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This guide will take you through the relevant steps to successfully use the KeyTag products. 
You will learn how to

 install the software,

 configure KeyTags for recording,

 retrieve the recorded readings,

 display and analyse the data and 

 configure the available options in the software so you can make best use of its 
features.

The chapters in this guide are placed accordingly. Experienced users of the software may 
choose to skip chapters 1 and 2, however if you are about to use a newer version of a 
KeyTag or Interface Cradle we recommend you at least skim the installation chapter for any 
relevant changes. 

This guide covers version 2.3 of the KeyTag Analyser software. If you are unsure which 
version you are currently using, please read Finding your software version (on page
163) included later in this guide. If you are using an older version, where you find a feature 
described in this guide that does not appear in your software, we recommend you update it 
as explained in Getting updated software. You can always get the most up to date version of
KeyTag Analyser and a current version of this User Guide from the KeyLog Recorders 
website at www.keylog.nl.

This guide includes all the relevant information to install and use the product range supplied 
by KeyLog Recorders, however occasionally the the reader is expected to be familiar with 
using a computer and the Windows® operating system.

Feedback, positive or negative, about the software, the KeyTag products and this guide is 
welcome. If you believe the products could be improved, please send us your comments.
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To use your KeyTags you will first need to install KeyTag Analyser on your computer. 
This will allow preparing the KeyTag for recording, retrieving the readings from 
memory and analyze the data.

This chapter will take you through the steps necessary to successful install the 
software on to your computer. It should be very familiar to users that have previously 
installed other software, which is why some experienced users may choose to skip this 
chapter. If you are new to using a computer and/or unsure about installing the 
software, we recommend you read the remainder of this chapter.

In This Chapter

System requirements..............................................11
Getting a copy of the software................................11
The installation process..........................................13
Upgrading KeyTag Analyser....................................14
Starting the software..............................................16
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System requirements

To ensure that the software will work on your computer following minimum 
specifications are required:

 PC capable of running Windows XP or later, or Windows 2003 Server or later

 45MB free disk space

 Internet Explorer 5.0 or later

 1 available serial port and/or 1 available USB port, depending on purchased 
interface

 1024 x 768, or higher, screen resolution.

 256 screen colours

The recommended specifications are:

 Processor equivalent to Pentium IV or later

 512MB of available RAM

 Internet Explorer 6.0 or later

 65535 (16bit), or more, screen colours.

If you are unsure of what your computer specifications are, please read the section 
about Finding your computer specifications (on page 168), which will help you 
locate the relevant information.

Getting a copy of the 
software

The software is available for download from the KeyLog Recorders website at 
www.keylog.nl. KeyLog Recorders does not charge for the download or use of this 
software, or for updates. You are welcome to distribute copies of the KeyTag Analyser 
software provided it is distributed unaltered and in the packaged format as originally 
downloaded from the KeyLog Recorders website.
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To obtain the software, visit the KeyLog Recorders website and navigate to the 
software download page. Complete and submit the download request form. Within a 
few minutes you will receive an e-mail at the address entered in the form with a link 
for the latest download file. Click on the link and confirm whether you wish to open the
downloaded file or save it to a folder on your PC.

Figure 1: Confirmation download file request IE9

Figure 2: Confirm download request in Mozilla Firefox
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Depending on the type of browser and its version you may get different windows to 
start and process the download. Modern browsers like Windows Explorer, Google 
Chrome or Mozilla Firefox typically have a special directory into which all downloads 
are copied.

Figure 3: Downloading the KeyTag Installer using Internet Explorer 9

Figure 4: Downloading the KeyTag installer using Mozilla Firefox

Figure 5: Downloading the KeyTag Installer using Chrome

If you have an older browser, we recommend you select a folder on your PC that you 
can easily access (such as the "Documents" or "Downloads" folder), but you are free to
choose any folder for which you have write permissions. The downloaded file is a 
single executable installer file; no other files are required for installation of KeyTag 
Analyser software on your computer.

Once the installation process has completed, the installer file is no longer required and 
can safely be deleted.

The installation process

To install the KeyTag Analyser software, locate the installation file downloaded in the 
previous step and execute it (typically by double clicking or selecting the file in 
Windows Explorer and pressing ). Follow the on-screen instructions. Initially, the
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process will require you to enter data such as your organisation and name, and select 
installer language and the program's storage location. We recommend you leave all 
options at their default setting, especially if you are unsure of what option to select or 
what changing the option would mean.

To proceed through each step of the installation process, click the "Next" button. If 
you want to change a previous step you can click the "Back" button. When all required 
data have been entered, click the "Finish" button to complete the installation process. 
If you want to stop installing the software, click the "Cancel" button.

The drivers required to operate your USB interface are installed as part of the main 
installation process. From time to time updated drivers may be released by KeyLog 
Recorders. These drivers will be available through the Microsoft Windows ® Update 
feature, as an optional hardware update, or as part of an upgraded installer file (see 
Upgrading from earlier versions on page 14.)

Upgrading KeyTag 
Analyser

KeyLog Recorders will publish updates to KeyTag Analyser to introduce new or 
enhanced features or to support new KeyTag models. You can get these updates...

 ... automatically, if you have enabled "Automatic Updates" (see Software 
Updates on page 147)

By default, this option is turned on. We recommend leaving this turned on, so you 
will automatically be notified when an update is available. You will see the following
window, letting you choose to whether or not you wish to update at this stage:

Figure 6: Update found available for download
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 ... through the Help menu by selecting "Check Internet for update..."

When you select this option, KeyTag Analyser will check the KeyLog Recorders 
website for a newer version of the software

Figure 7: Checking for an update on the internet

Neither of these two options will transmit any information about you or your system
to KeyLog Recorders, so you can rest assured your privacy is maintained.

 ... by downloading an upgraded installer file from the KeyLog Recorders website.

This requires you do check yourself if the version currently offered for download is 
more recent that the one installed on your PC. You can find the version number of 
the software installed on your PC in the Help menu (see "Finding your software 
version" on page 163).

KeyLog Recorders recommend that you always use the latest version of the software. 

If a newer version is available, you can download the updated version on page 11 
of the installer file to your PC and then proceed with the installation process on 
page 13. The older version of the software will be replaced with the new version.

Installing a newer version will update all the relevant program files. It will not affect 
any of your KeyTag data files or your custom settings of the software. You may 
however need to check any shortcuts to the program you made, as the location of the 
program files can change. 

If you are upgrading from version 1.7r10 or earlier, the installed unsigned USB drivers 
will not be replaced automatically. To replace the USB drivers you will need to go to 
Windows Update and select the FTDI - USB Interface update from the "Other 
hardware" section. Please refer to your Operating System manual or help on how to 
access this feature.
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You can also update your driver from the Control Panel device manager. Please see 
Resolving USB Driver Problems later in this document.

Starting the software

At the conclusion of the installation process click Finish to close the installer window.

 

You can start the software ...

 ... by  double clicking the "Shortcut" on the desktop
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 ... by navigating to the "Shortcut" in the "Start" menu system.

Click on the "All Programs" item to locate the "KeyTag Analyser" shortcut, similar to
the following picture:

 ... by selecting the KeyTag Analyser tile from the Start screen

Please refer to your operating system documentation for further assistance about 
program locations and how to execute programs.
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This chapter will cover how you prepare your KeyTag for use, how to start it and how 
to retrieve and analyse the recorded information. Subsequent chapters will explain this 
in more detail, and also show you how you can customise KeyTag Analyser's settings 
to make your work easier.

In This Chapter

Connecting the Interface........................................19
Using the KeyTag with the Interface........................20
Preparing a KeyTag for recording............................21
Starting and using the KeyTag................................27
KeyTag light patterns.............................................29
Retrieve information from KeyTag...........................30
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Connecting the Interface

The interface cradles available from KeyLog Recorders connect to either a serial 
(RS232) port or a USB (Universal Serial Bus) port, depending on the model you 
purchased.

The ports for serial (RS232) communication devices are typically located at the rear of 
the computer as shown here:

Figure 8: Rear of PC with one serial port (RS232)

Insert the plug into the port with the correct orientation. We recommend you tighten 
the securing screws when the connector is plugged in so that it does not accidentally 
pull out during use.

The ports for USB devices are typically also located at the rear of the computer, but 
you may find other ports at the front or sides of your computer. If you are using a USB
hub we recommend it has its own power supply.

Figure 9: Rear of PC with 4 USB ports

Connectors for USB devices will often display a USB logo such as this one so you can 
identify them easier:

KeyTag Analyser can communicate with multiple interface cradles at the same time; 
you may connect as many serial and/or USB interface cradles as the computer 
supports, although we find that connecting more than 4 interfaces becomes 
impractical.
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If you install KeyTag Analyser on a computer with no internet connection you must 
ensure USB interface cradles are not connected until the installation is completed, 
since the required drivers are installed as part of KeyTag Analyser.

If the software cannot identify a connected USB interface cradle there may have been 
a problem during the installation of the software. Please refer to the FAQ on the 
KeyLog Recorders website for further information.

Using the KeyTag with 
the Interface

Depending on the product you want to download you will need one of two different 
interface cradle types.

Most products use the standard interface cradle, where the KeyTag is inserted into the 
slot from the top as shown to enable communication. You will be able to see the 
contact pins inside the slot that meet with the matching contact pads on the KeyTag. 
When inserting a KeyTag into the slot you feel a slight resistance as the contacts 
engage. Removing the KeyTag will cause a slight clicking noise as the contacts snap 
back into their unloaded position.

The indicator products TIC20 and TICT use a special cradle in which the contact pins 
are exposed at the top. To enable communication locate the indicator's lug on the 
interface's boss and firmly press it down, so the contact pins pierce through the rear 
label.
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Figure 10: TICT interface cradle

You can connect both interface types to your computer at the same time, provided you
use different ports.

KeyTag Analyser will automatically download 
and display any readings or statistics stored 
inside the KeyTag.

The download process will only take a few 
seconds, but you can stop it if needed by 
clicking on the  button or pressing the 
"Esc" key.

Preparing a KeyTag for 
recording

You can use two different methods to prepare a KeyTag so it records information.

Using the KeyTag Wizard

You can use the KEYTAG WIZARD by either clicking the icon ( ) on the standard toolbar, 
or by clicking WIZARD in the KEYTAG menu.
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1 The WELCOME screen is displayed.

2 All connected interface cradles are checked for inserted KeyTag's. If any of them 
contain previously recorded data these are downloaded and saved.

3 A configuration window is displayed where you can enter details about the next 
recording trip, such as interval and duration.

4 The entered configuration data are uploaded to connected KeyTag's.

Without using the KeyTag Wizard

You can click CONFIGURE in the KEYTAG menu or use the F3 key. In this case the 
downloading and saving of data is skipped.

1 All connected interface cradles are checked for inserted KeyTag's.

2 A configuration window is displayed where you can enter details about the next 
recording trip, such as interval and duration.

3 The entered configuration data are uploaded to connected recorders.

You can also use pre-configured profiles, or quickly re-configure a KeyTag with the 
same settings as used for the previous recording. For more details on these options 
please see Configuration Profiles (on page 55) and Quickly re-configuring 
KeyTags (on page 60).
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Welcome
First the Wizard has a welcome screen (this is "1" on the Action List). This asks you to 
make sure you have not neglected to place the KeyTag firmly in the Interface Cradle.

The Wizard is responsible for certain "Action Steps" and these are clearly listed at the 
left in the wizard window. 

To get to the next screen, click on  and the next wizard screen will appear. The
green arrow will indicate you have moved to Step 2.
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Locate KeyTag(s) download and save relevant 
data

In this screen you will see one of the following pictures next to each of the items in the
list:

 (no picture) indicates the software is still using this communications port.

  Data was successfully retrieved from the KeyTag and stored/saved to disk.

  Data was successfully retrieved from the KeyTag but there was no need to save 
the information to disk.

  The software was unable to detect an Interface Cradle connected to the 
communications port or was unable to detect a KeyTag in the Interface Cradle.

  The KeyTag is a single use logger and cannot be prepared for use again and 
should therefore be returned to the supplying distributor or agent once you have 
finished with the KeyTag. You will still be able to continue to retrieve information 
stored within the KeyTag.

The KeyTag should be almost instantly recognized by serial number and the number of
readings. It is possible to have and use more than one communication port at a time 
and if so, the wizard will find all the KeyTags.

The communication ports that are not in use (the ones that initially are reported with 
the  mark) can be removed from view by selecting an option (see "Communication 
Ports" on page 145). You don't have to do that now, but you can do it later to clean up
the "wizard window" appearance.
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To get to the next screen, click on  and the third wizard step screen will 
appear. The software will automatically proceed to the next wizard step, as if the user 
clicked on , if each of the Interface Cradles detected have a KeyTag detected in
them and the information within the KeyTag was successfully retrieved.

Configure KeyTag(s) for next use

The options are available so you have appropriate control over the way the KeyTags 
will behave and store data for the upcoming period of recording. These options are 
explained in more detail in the chapter "Preparing KeyTag for use on page 31". 
Click  to record the configuration data and you will see the final confirmation 
screen.
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Prepare KeyTag(s) for next use
The last Wizard screen involves sending the new configuration data to each KeyTag to 
prepare them for their next use. While the software is sending the new configuration 
data to each KeyTag the top of the window will look similar to the following picture. 
The process of sending the new configuration data to each KeyTag should take less 
than 20 seconds in total to complete.

Once the software has finished uploading the updated configuration information into 
each KeyTag, the window displaying the progress will look similar to the following 
picture.

In this screen you will see one of the following pictures next to each of the items in the
list:
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 (no picture) indicates the KeyTag is still in the process of being prepared for its 
next use.

  The KeyTag was successfully prepared for its next use.

  The KeyTag failed to be prepared for next use. Press  to try again.

  The battery within the KeyTag is low and is unlikely to have enough capacity to 
record all the data you want during its next use. In this situation the KeyTag should
no longer be used.

When all KeyTags have finished receiving their new configuration data, click  to
close the wizard. Your KeyTag(s) are now ready to be started and used.

Please note that the automatic download feature is disabled in this screen. If you use 
the  button to configure a different KeyTag, you may update the configuration 
of a KeyTag with unsaved data.

Starting and using the 
KeyTag

Once a KeyTag has been successfully configured for use it is ready to be started. There
are two discrete methods available to start a KeyTag recording, which are selected 
during configuration. These start methods are explained in more detail in the chapter 
"Preparing KeyTag for use on page 31".

1 By pressing and holding the START MARK button on the KeyTag until both the OK 
and Alert lights alternately flash on and off. 

2 By waiting until the date/time defined during configuration is reached, at which 
time recording will automatically commence. Pressing the START MARK button will 
have no effect until recording has commenced.

You can also have the KeyTag record an "inspection" mark at any time while it is 
recording, simply by pressing and holding the START MARK button on the KeyTag until
both the OK and Alert lights flash on and off at the same time. You may have the 
KeyTag record as many inspection marks as you want while it is recording, however 
only one inspection mark can be recorded per reading. In other words, if your KeyTag 
is configured to take readings at 15 minute intervals, inspection marks can be recorded
at intervals of 15 minutes or more. If the KeyTag has finished recording then pressing 
the START MARK button will have no effect until after the KeyTag has been prepared 
for next use.
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Once the KeyTag has started recording (either via Start button or date/time start) the 
Alert and OK indicator lights operate as detailed in the section about KeyTag light 
patterns on page 29.

Figure 11: Identifying the parts on a KeyTag
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KeyTag light patterns

KeyTags without a display signal a number of different events or status information by 
using their LED's. The table below contains a summary of the light patterns you may 
come across during use.

Signal Sequence Occurrence

KeyTag 
wake-up 
signal

Sequence of four 
alternate flashes of 
green-red LED’s

 displayed after configuration has been 
successfully applied to the KeyTag. 

 when a KeyTag is woken up from hibernation 
(see "Hibernation - Prolonging battery life" on 
page 61) state.

Not to be mixed up with... 

KeyTag start-
up signal

Sequence of sixteen 
alternate flashes of 
green-red LED’s

 displayed when the KeyTag starts its recording 
cycle. 

Mark signal Sequence of five 
simultaneous flashes
of green and red 
LED’s

 displayed when pressing start/mark button while 
recording to indicate an inspection mark in the 
software. 

 displayed directly after the start-up signal 
following a push button start where a recording 
delay has been configured. In this instance the 
start-up signal is repeated when the actual 
recording begins. 

Logging 
active, no 
alert present

Single flash of green
LED every 4 seconds
(approx.) 

 indicates KeyTag is recording. 

This is not displayed when pre-start is active and 
the main logging cycle has not yet started. It is 
also not displayed when the green LED has been 
turned off in the configuration screen. 

Logging 
finished, no 
alert present

Single flash of green
LED every 8 seconds
(approx.)

 indicates KeyTag has finished recording.

This is not displayed when the green LED has 
been turned off in the configuration screen.

Will also be displayed when unit has been woken 
up from hibernation. 

Alert 
condition 
present

Single flash of red 
LED every 4 seconds

 displayed when the KeyTag has detected an alert
condition (see "Alert Processing" on page 42) 
and the Alert LED has been activated.

If an alert is present you cannot determine if the 
unit is still logging or has finished its log cycle. 
The Alert LED will flash every 4 seconds to ensure
an alarm condition is not overlooked.

Communicati
on

The green LED will 
flash occasionally

 during communication with the interface the 
green LED will flash occasionally; no information is
conveyed in this. 
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Start button 
press

red LED glows 
faintly

 This is by design but conveys no information. 

Retrieve information 
from KeyTag

When you are ready to view the recordings that are stored within the KeyTag, just 
place the KeyTag into the Interface Cradle as before. If the KeyTag is still recording 
when you go to retrieve the readings it will continue to record without interruption so 
you will be able to download again later if you choose.

If the KeyTag has readings stored within its memory, the software will automatically 
start to retrieve a copy of the recording contained within the KeyTag and will also 
display an animated picture during the download process, similar to the following 
picture.

Once the readings have been successfully retrieved from the KeyTag(s), the software 
will display the information for you. The chapter "Results from KeyTag (on page
64)" explains in more detail the information that is displayed to you as a result of 
retrieving the recorded readings from KeyTag(s).

Your KeyTag may now also be reconfigured for another trip with the same settings as 
before, if you have this option activated. 

30 KeyTag User Guide (2.3) 



Before you can use a KeyTag to monitor and record environmental conditions you must
first prepare it for use. The process of preparing a KeyTag for use allows you to define 
a number of parameters, including:

 How long it should record the environmental condition for, so that you can 
be assured that it will record for the duration of time required. For example, 
if you want it to monitor a shipment that will take 10 days to deliver, you 
will be able to make sure it will record the humidity and/or temperatures 
throughout the entire 10 day period.

 How often it should record the environmental conditions.

 Under what conditions it should display an alert. An alert indicates when the 
environmental condition being recorded is not within set limits.

This chapter explains how to prepare a KeyTag for use and what the options mean.

In This Chapter

Getting a KeyTag ready for use...............................32
Restricting Access..................................................33
Preparing KeyTag for next use................................35
Alert Processing.....................................................42
Advanced Alert Settings..........................................46
Display Logger Alarms............................................50
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Getting a KeyTag ready 
for use

There are two ways to prepare a KeyTag for use, both of which will achieve the same 
result. Once a KeyTag has been through the configuration process to get it ready for 
next use, any readings previously recorded will no longer be available for retrieval.

 Click the KeyTag icon ( ) on the toolbar or the "Wizard..." menu item located in 
the KeyTag menu.

This is the safest option, as it will retrieve any readings that are stored within the 
KeyTag and save them to disk before getting the KeyTag ready for next use. This 
option is useful when you are unsure whether or not the readings stored within the
KeyTag have been previously retrieved and saved to disk.

 Click the "Configure..." menu item located in the KeyTag menu.

This is the quickest option, as it does not involve the step that retrieves any 
readings that are stored within the KeyTag. This option is useful when you know 
you have previously retrieved the readings or you no longer need a record of the 
readings that are currently stored within the KeyTag.

The wizard will appear once you have selected the option of your choice to guide you 
through the necessary steps to prepare a KeyTag for next use. While the wizard is 
visible the "Automatic download" feature will be disabled.
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Restricting Access

Users can enable a password protection feature. Once enabled, a user will need to 
provide the correct password when next setting up the KeyTag for recording.

Figure 12: Password entry dialogue

A confirmation of this password is required. 

Tip: Very often users tick the password required boxes, but don't enter a password. 
Such an "empty" password is valid, hence the password request dialogue will appear 
when re-configuring such a unit. In this case simply selecting  will advance to 
the next screen.

Protecting Recorded Data
Various models offer the option to request a password also when the logger is 
downloaded. This function can be enabled when configuring the logger by ticking the 
box next to "Download requires password":

Some models do not have this feature enabled, but can be upgraded. In this case a 
further check box appears on the configuration screen:

The check box "Download requires a password" is greyed out if the update has not 
previously been applied to the logger being configured. Once you select the "Update 
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logger to enable this feature" box, the "Download requires a password" box becomes 
available for activation. You can then select the password functions for either 
configuration or download. The logger will be permanently upgraded as soon as the 
configuration is applied.

Following should be noted:

 The update cannot be reversed.

 If the "Update logger to enable this feature" is selected, the upgrade will perform, 
regardless whether any of the "...requires a password" tick boxes are enabled or 
not.

 If multiple units are configured at the same time using more than one interface, all 
units will be upgraded if the Upgrade option is selected.

 If this upgrade is applied, KeyTag Analyser 1.8r9 or later will be required to access 
the loggers. Older versions will display an error message if communication is 
attempted.

 When the "Again" button is used with a different unit, that unit will also be 
upgraded.

 Data files cannot be protected by passwords.

 If a unit has been upgraded in a previous session, and is now configured using the 
"Download requires a password" function, units configured with the "Again" button 
in the same session will not automatically be upgraded; only those units that have 
already been upgraded separately in a previous session will have the "Password on 
download" function enabled.

Password Rules
The password can be up to 6 characters long and can contain a mix of letters, 
numbers and special characters. The selected input language of the computer's 
operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the 
language used is stored inside the recorder. Users will then need KeyTag Analyser 2.3 
Release 7 or later so the password is correctly interpreted.

If you use special characters for languages such as Japanese or Chinese the maximum 
number of characters that can be used will be reduced due to the increased memory 
required to store the characters.

Please see Code Pages on page 173 for a more detailed explanation.
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Preparing KeyTag for 
next use

The "Configure KeyTag(s) for next use" step provides you with all the options that can 
be configured to affect how a KeyTag records data during its next use. This screen is 
automatically presented when you use the wizard, however, you can also configure 
KeyTags by clicking CONFIGURE from the KEYTAG menu.

Wen you have entered the details and adjusted the settings as desired, click  to
send the configuration information to the KeyTag(s).

The following table describes each configurable option that is permitted to change.
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Function Purpose

User ID This can be used for identification of the load in transit to be 
monitored, or simply an identifier that describes the purpose 
of the monitoring. Bill of Loading information, Shipper, 
commodity, contact name and other relevant information can
be placed here.

The User ID can be up to 38 characters long (36 for 
recorders witha display) and can contain a mix of letters, 
numbers and special characters. The selected input language
of the computer's operating system determines which special 
characters can be selected.

If a user decides to make use of special characters, extra 
information about the language used is stored inside the 
recorder. Users will then need KeyTag Analyser 2.3 Release 7
or later so the User ID is correctly displayed.

If you use special characters for languages such as Japanese 
or Chinese the maximum number of characters that can be 
used will be reduced due to the increased memory required 
to store the characters.

Please see Code Pages on page 173 for a more detailed 
explanation.
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Start method This is used to determine how/when the KeyTag will start 
recording its next set of readings.

 Push button start

When the 'Push button start' option is selected, the KeyTag will 
start recording when the START MARK button has been pressed
and held until both the OK and Alert lights alternately flash on 
and off. If pre-start recording is enabled, the KeyTag will start 
logging pre-start readings immediately (see section "Pre start 
data collection on page 53").

 Date/Time start

When the 'Date/Time start' option is selected, the KeyTag will 
automatically start recording at the date/time defined in the 
subsequent field. Pressing the START MARK button prior to the 
start date/time will have no effect. There will be no pre-start 
readings recorded prior to the start date/time.

Note: When using the Date/Time start option, the earliest start 
time that can be selected is two minutes after the current time. 
This delay allows you to complete the remaining configuration 
options and gives the software enough time to configure the 
KeyTag before it starts.

 Push button start from hibernation

When the 'Push button start from hibernation' option is 
selected, the KeyTag will start as if programmed for 'Push 
button start'. The difference is that once the configuration is 
successfully uploaded to the KeyTag it will be placed into 
hibernation. When the START MARK button has been pressed 
and held, the KeyTag will wake from hibernation and start 
recording with the parameters as configured.

Please note in this mode the real time clock inside the logger is 
not active. It is therefore vital that the computer on which the 
unit is later downloaded is set to the correct time.

Please see Prolonging battery life (see "Hibernation - 
Prolonging battery life" on page 61) for more information on 
Hibernation.

Not every KeyTag model can support every start mechanism. 
As a result, specific options may not be be listed when 
configuring a KeyTag.

Enable pre-start 
logging

Pre-start logging is a feature that protects the recording in 
the event of a failure to actually press the START MARK 
button to initiate the recording. It is an insurance policy 
against the loss of critical data. This is almost always checked
for transit monitoring applications. This option is further 
explained in the section Pre start data collection on page
53.
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Record readings 
continuously, 
overwrite oldest when
memory full

This is what is called a "data wrap" in which the recorder just
keeps writing data to memory. It is a "moving window" of 
data. For example, this is useful for fixed base MKT 
monitoring with the interval set to one year, so that the 
current "yearly MKT" can always be in the memory of the 
KeyTag. If this option is selected, the user will be "opted out"
of the next two options. This option is further explained in 
the section Continuous operation (on page 53).

Record readings so 
that:

If this is selected, the logger stops logging when the number 
of data points has been gathered and stored in memory that 
spans at least the number of days specified below. When this
option is selected, the following two options will determine 
the number of data points over the span of time that will be 
recorded.

Readings recorded 
will span at least X 
days

If you know how long you want to record, the Configuration 
screen will automatically set the number of readings to be 
collected at a particular interval. This setting will only have an
effect if the above option "Record readings so that:" is 
selected.

Number of readings 
to record X maximum
is Y

This data box will display the calculated number of readings if
you select a time span and an interval. Alternatively, you can 
select the number of readings desired, and the time span will
be altered based on the interval. If this is selected, the logger
will stop logging when the number of readings has been 
gathered and stored in memory. "Y" represents the maximum
number of readings the KeyTag can store, however with a 
selected interval and a selected time span, you may not need
to use all of the available data space. This setting will only 
have an effect if the above option "Record readings so that:" 
is selected.

Record a reading 
every X 

This determines how frequently the KeyTag records the 
environmental humidity and/or temperature into its internal 
memory.

Begin recording after 
a delay of X

Determines how long after the START MARK button on the 
KeyTag has been pressed that it will actually begin to record 
the environment humidity and/or temperature. This feature is
useful for example, when the KeyTag could falsely trigger an 
alert because the environmental conditions it is being started 
in is quite different to the environmental conditions to be 
monitored. If pre-start logging is enabled, the KeyTag will 
continue to record pre-start readings during this delay.

Enable the OK 
(Green) indicator

This determines whether or not the green light should 
function while the KeyTag is recording after being started.
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Humidity / 
Temperature

These tab controls will allow the humidity and temperature 
alert conditions to be configured independently. These tab 
controls will only appear when configuring a KeyTag that has 
a humidity and a temperature sensor. If the KeyTag has only 
one sensor then the following alert conditions will apply to 
that sensor.

Configure requires a 
password

This feature allows the user to define a password that 
must be provided (see "Restricting Access" on page 33) to 
configure the KeyTag next time. If this option is enabled and 
the password changes, the user will be required to verify 
the new password (see "Verify Access Password" on page
52) when the wizard progresses to the next step. Passwords 
are case sensitive and therefore the passwords "Bob" and 
"bob", for example, are different.

Download requires a 
password

If this option is enabled, the KeyTag's recorded data can only
be downloaded after entering the correct password. 

Note: Only one password can be provided for each KeyTag. 
The same password applies to the Configure and Download 
actions.
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Upgrade logger to 
enable this feature

KTL-108, KTL-208 and KTL-218-T loggers which do not yet 
have the "Download requires a password" feature can be 
upgraded. These units will then require KeyTag Analyser 
revision 1.8r9 or later to be configured or downloaded, and 
an error  message will be displayed in older versions.

If KeyTag Analyser configures such a logger, an additional 
check box is displayed: 

The “Download requires a password” is grayed out if the 
update has not previously been applied to the logger being 
configured. Once you tick the “Update logger to enable this 
feature” box, the “Download requires a password” check box 
becomes available for activation. You can then select the 
password functions for either configuration or download. The 
logger will be permanently upgraded as soon as the 
configuration is downloaded.

Note:

 The update cannot be reversed.

 If the “Update logger to enable this feature” is ticked, the 
upgrade will perform, regardless whether any of the “...requires
a password” tick boxes are enabled or not.

 If multiple units are configured at the same time using more 
than one interface, all units will be upgraded if the Upgrade 
option is selected.

 When the “Again” button is used with a different unit, that unit 
will also be upgraded.

Note: If a unit has been upgraded in a previous session, and
is now configured using the “Download requires a password” 
function, units configured with the “Again” button in the 
same session will not automatically be upgraded; only those 
units that have already been upgraded separately in a 
previous session will have the “Password on download” 
function enabled.

If the battery within the KeyTag is detected to be low and therefore not recommended
for further use, the software will display a warning to you in the top right corner, like 
the following example.
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Some KeyTag models display the remaining percentage in this screen once it falls 
below half capacity. Some models cannot be configured any longer once their battery 
capacity falls below a pre-determined threshold.
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Alert Processing

The KeyTag can display a visual alert if one or more of the configured alert conditions 
have been met. An alert condition can be a single alert reading (a reading outside of or
including the upper and lower threshold values), a combination of consecutive alert 
readings or a total of alert readings encountered during the trip. 

The threshold parameters are identified in KeyTag Analyser when the KeyTag's 
readings are downloaded and displayed.

Please note that matching these to known conditions of interest in your monitoring 
program may require some information about the effects of exposure to different 
durations of out-of-range humidity and/or temperatures.

As with the other logging parameters these are adjusted in the "Configure KeyTags for 
use" screen. 

The following table describes each configurable option.

Function Purpose

Enable the Alert 
(Red) indicator when

This determines whether or not the red light should activate 
when an alert condition has been detected. An alert occurs 
when one or more of the conditions described below have 
been met. When an alert condition has occurred, this 
indicator will flash at a regular interval.
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Readings below X or 
above Y (inclusive)

You can set the upper threshold limit and lower threshold 
limit by entering the appropriate information in the boxes. If 
readings stay inside the range specified by X and Y the alert 
indicator will not activate. If a reading of X and below, or Y 
and above is recorded, the alert indicator may light up, 
dependent on the alert conditions. Charts will display alert 
readings according the settings made in the Charts (on page
119) section of the 'Options' Screen.

Note: The values entered in these boxes are included in the 
alert range. In the above example 7 consecutive readings of 
45°C will trigger an alert, whereas 7 consecutive readings of 
44.9°C will not trigger an alert. Please set your alert values 
with this in mind.

After X consecutive 
alert readings (W 
minutes)

Tick this box, and enter a number into the adjacent field if 
you want to trigger an alert condition once X number of 
consecutive alert readings are recorded. Note that the 
number of minutes shown will depend on the number of alert
readings you enter into the box AND the recording interval 
already specified. For example, if X is 3 and two readings are 
above the upper threshold limit but the subsequent reading is
below the upper threshold limit and still above the lower 
threshold limit then the alert indicator will not activate. 
Maximum value is 256, minimum is 2.

After X alert readings 
have occurred (W 
minutes)

Tick this box, and enter a number into the adjacent field if 
you want to trigger an alert condition once a total number of 
alert readings have been recorded, regardless of whether 
they are consecutive or not. Maximum value is 256, minimum
is 2.

You can increase or decrease the values with the arrows next
to the fields. Please note these are linked and certain 
combinations may not be allowed.

Leave alert indicator 
enabled even if 
readings return within
alert range

If this option is enabled then the alert indicator will remain 
active, even if the current reading does not meet the alert 
conditions specified by the previous controls.

If this option is disabled then the alert indicator will remain 
active only if the current reading meets the alert conditions 
specified by the previous controls.

Please note, however, that this setting is only applicable if an
immediate alert is configured; if consecutive or accumulative 
alert settings are configured this box has no effect, and the 
alert indicator will always remain visible once an alert has 
occurred.
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Clear and reset alert 
when START MARK 
button pressed

If this feature is enabled, any user can turn off an active alert
by pressing the KeyTag's START MARK button. It will also 
reset the internal alert counters such that it would be as if no
alert condition had occurred at all while the KeyTag was 
recording.

Should the KeyTag subsequently detect a further alert 
condition, the alert will activate again.

Once the KeyTag has finished recording, pressing the START 
MARK button will not clear and reset any active alert. 

If the KeyTag being configured does not support this feature,
it will be disabled and its setting cannot be changed.
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Example:

You wish to configure a KeyTag so alert conditions are indicated if 5 continuous 
readings are out-of-range or 7 total readings are out-of-range. Alert parameters should
be set as follows:

This table shows how different conditions would result in the Alert Indicator flashing or
not:

What the KeyTag recorded What the KeyTag indicated

2 readings out-of-range, return to 
normal, 2 readings  out-of-range, 
return to normal, 2 readings out-of-
range, return to normal

Neither alert condition is met.
The maximum number of consecutive out-
of-spec readings is only 2 (5 required.)
The total out-of-range events equals 2 + 2 
+ 2 = 6. The alert condition is 7 total, so 
the alert does not go off. 

No Flashing Red Alert Indicator

4 readings out-of-range, return to 
normal, 4 readings out-of-range

The first alert condition is not met, as the 
the maximum number of consecutive alert 
condition readings is only 4 (5 required.)
The second alert condition however IS met 
since the total alert condition readings 
equals 4 + 4 = 8. The alert condition is 7 
total. so the alert DOES go off.

Flashing Red Alert Indicator

4 readings out-of-range, return to 
normal, 2 readings out-of-range

Neither alert condition is met.
The maximum number of consecutive alert 
condition readings is only 4 (5 required.)
The total number of alert condition readings
equals 4 + 2 = 6. The alert condition is 7 
total, so the alert does not go off.

No Flashing Red Alert Indicator
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6 readings out-of-range, return to 
normal

The second alert condition is not met, as 
the total out-of-range events equals 6 (7 
required.)
The maximum number of consecutive alert 
condition readings however is 6, the alert 
condition is 5 consecutive readings, so the 
alert DOES go off.

Flashing Red Alert Indicator

Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is recorded out-of-spec, 
place a tick in the box next to "Enable the Alert (Red) indicator when" and remove the 
ticks in both boxes next to the "After X consecutive alert readings" and "After X alert 
readings have occurred".

2. You can not enter a number into the "After X consecutive alert readings" field which 
is larger than the number in "After X alert readings have occurred", since the latter 
alert condition would always be met first.

3. Similarly, you can not enter a number into the "After X alert readings have occurred"
field which is smaller than the number in  "After X consecutive alert readings". The 
software will adjust field values as appropriate.

Advanced Alert Settings

Some KeyTags support more detailed alert settings than described before. If KeyTag 
Analyser encounters one of these loggers, an additional  button is visible in the 
bottom left of the configuration screen.

When this button is pressed, the alert configuration screen changes and displays 
additional settings:

The red alert indicator can now be configured independently for upper and lower alert 
values.
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Function Purpose

Readings above X
Readings below Y

(inclusive)

In addition to entering the threshold levels, tick the boxes 
next to "Readings above" or "Readings below" to enable the 
alert conditions for only the upper or only the lower 
threshold settings, or for both. If both boxes are ticked, the 
behaviour is the same as for the standard alert settings. The
charts will display alert readings according to the settings 
made in the Charts (on page 119) section of the 'Options' 
Screen.

After X consecutive alert 
readings (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings 
below" to establish whether only readings above and 
including the upper threshold or only readings below and 
including the lower threshold should count towards the 
consecutive alert readings. If both boxes are ticked, the 
behaviour is the same as for the standard alert settings. If 
the Alert Indicator is disabled for either the upper or the 
lower alert, the respective box for the consecutive alert is 
grayed out and cannot be ticked.

After X alert readings 
have occurred (W 
minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings 
below" to establish whether only readings above and 
including the upper threshold or only readings below and 
including the lower threshold should count towards the total 
number of alert readings. If both boxes are ticked, the 
behaviour is the same as for the standard alert settings. If 
the Alert Indicator is disabled for either the upper or the 
lower alert, the respective box for the alert total is grayed 
out and cannot be ticked.

The advanced settings are displayed automatically without the need to press  if
an advanced configuration is already found in the logger to be configured. If you do 
not wish to use the advanced settings, press , and the standard Alert 
Processing (on page 42) configuration screen is displayed.

Example:
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You wish to configure a KeyTag so an alert is displayed if 5 continuous readings are 
out-of-range or 7 total readings are out-of-range, but only if the temperature goes to 
20ºC and above. You wish to see in KeyTag Analyser if the product has gone to 0ºC 
and below, but you do not wish to trigger an alert for this condition. Alert parameters 
should be set as follows:

This table shows how different conditions would result in the Alert Indicator flashing or
not:

What the KeyTag recorded What the KeyTag indicated

2 readings of 20ºC or above, return to 
normal, 8 readings at 0ºC or below, 
return to normal, 4 readings of 20ºC or 
above, return to normal

Neither alert condition is met.
The maximum number of consecutive out-of-
spec readings is only 2 (5 required, the 8 
readings below 0ºC do not count towards 
alert readings).
The total out-of-range events equals 2 + 4 =
6. The alert condition is 7 total, so the alert 
does not go off, as again the 8 readings 
below 0ºC do not count towards alert 
readings. 

No Flashing Red Alert Indicator

4 readings of 20ºC or above, return to 
normal, 4 readings of 20ºC or above

The first alert condition is not met, as the the
maximum number of consecutive out-of-spec
readings is only 4 (5 required.)
The second alert condition however IS met 
since the total out-of-range events equals 4 
+ 4 = 8. The alert condition is 7 total. so the
alert DOES go off.

Flashing Red Alert Indicator
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Separate alert conditions are useful if you expect the monitored product to encounter 
temperatures lower than the lowest possible alert temperature. In this case a flashing 
alert indicator may not necessarily indicate an unfavourable condition was 
encountered. In programs where such conditions are monitored the lower alert should 
be turned off.
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Display Logger Alarms

KT-108-D and KTL-208-D loggers have a different settings screen.

The settings are similar to the Advanced Alert Settings on page 46, hence they are 
not explained again here. There is however one notable exception; for each range 
(above or below) you can only select either accumulative or consecutive readings, but 
not a combination of both. This does however give you the option to select e.g. a 
different number of cumulative readings for above and below ranges.

In this screen you can also see an  button. When clicking this button, 
following configuration screen is displayed, allowing you to enter parameters specific to
KT-108-D and KTL-208-D loggers.
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Function Purpose

Clear and reset alarm 
when STOP/CLEAR 
button pressed

If this option is enabled, any user can turn off an active 
alarm directly on the KeyTag by pressing the STOP/CLEAR 
button. This will turn off the alarm symbol and reset the 
internal counters as if no alarm had occurred while the 
KeyTag was recording. When the KeyTag subsequently 
registers a further alarm condition, the alarm will activate 
again. Once the KeyTag has finished recording, pressing the 
STOP/CLEAR button will not clear and reset any active alarm.

An alarm will always be registered in the day summary and cannot 
be cleared, regardless of whether the alarm symbol was cleared or 
not.

Alarm remains on 
even if readings 
return to non-
violation range

If this option is enabled then the alarm symbol will stay on, 
even if the current reading does not meet the alarm 
conditions specified by the previous controls.

If this option is disabled then the alarm symbol will stay on 
only if the current reading meets the alarm conditions 
specified by the previous controls.

Please note: Unlike for units without a display these settings also 
apply if consecutive or accumulative alert settings are configured. If
the Alarm conditions are no longer met, all counters are re-set and 
an alarm is triggered when the alarm condition is met again. In any
case, an alarm will be registered in the day summary, regardless 
whether conditions re-set or not.

Pause alarm/statistics
processing for X 
readings

If this option is enabled, pressing either button on the 
KeyTag while recording excludes the next reading from the 
alarm and statistics calculations; PAUSED will now be shown 
on the display. This allows the user to review the statistics or 
clear an alarm without causing an invalid reading, alarm or 
statistic.

Switch off display 
after 30 seconds

If this option is enabled, the display will turn off after 30 
seconds to save battery power.

Allow logging stop 
with STOP button

If this option is enabled, the KeyTag can be stopped by 
pressing the STOP button. The recorder will no longer take 
any readings, however you can still review the day statistics 
and download the logged results to a PC with KeyTag 
Analyser.
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Allow reset of logger 
with START button

If this option is enabled, KT-108-D and KTL-208-D loggers 
can be re-activated and used again for a new trip by pressing
the START button.

When re-activating the recorder, all previously 
recorded readings and statistics will be erased! 

When this option is enabled, a warning box will be displayed 
to remind you this is enabled and can result in loss of data.

Show total summary 
days collected

If this option is enabled, the KeyTag shows the number of 
days for which statistics have already been collected on the 
display.

Please refer to the KeyTag product specification & guide  documents for KT-108-D and 
KTL-208-D recorders on the KeyLog Recorders website at http://www.keylog.nl for a 
detailed description of the functionality of these products.

Note: When referring to KT-108-D and KTL-208-D products, versions with both the 
fixed (F-suffix) and replaceable (R-suffix) battery are included.

Verify Access Password

If the "Configure requires a password on page 31" option was enabled or the 
password was changed during the configuration process the user is required to verify 
the password before it will be stored in the KeyTag. A window similar to this will 
appear:

Once a password has been stored in the KeyTag, further access to it can only be 
achieved by providing the correct password. Therefore, if a password is forgotten 
further access to the KeyTag will not be possible. Passwords are case sensitive and 
therefore the passwords "Bob" and "bob", for example, are different.
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Pre-start data collection

The KeyTags support a feature called "pre-start logging", which can be selected during
configuration.

When pre-start logging is enabled the KeyTag will automatically start logging as soon 
as configuration is completed. It will record at the same sampling interval as defined in
the configuration and will continue to record until the user starts the KeyTag by 
pressing the START MARK button on the KeyTag. Once the KeyTag has been started, it
will record as per the configuration settings. While the KeyTag is recording pre-start 
readings the Alert LED on the KeyTag will not activate if an alert condition is detected.

Pre-start logging is useful as a fail-safe recording setting so if the KeyTag is not started
at the appropriate time, the readings will still be available to view later.

When the readings are retrieved from the KeyTag, any pre-start readings will be 
identified as pre-start readings so the user can quickly identify the readings recorded 
before and after the KeyTag was started.

All KeyTags have a finite amount of memory to store the readings it records. 
Therefore, while the KeyTag is recording pre-start readings the KeyTag will operate in 
its 'continuous operation' mode, which is explained further in the section "Continuous
operation (on page 53)". Once the memory within the KeyTag is full the oldest pre-
start reading will be overwritten with the latest reading recorded, regardless of 
whether the reading recorded is a pre-start reading or a reading to be recorded after 
the KeyTag has been started.

If a KeyTag has been configured to start recording at a certain date/time, or for push 
button start from hibernation, no pre-start readings will be recorded.

Continuous operation

All KeyTags have a finite amount of memory to store the readings that are recorded. 
When the KeyTag is recording readings continuously it will not stop once the memory 
within the KeyTag is full of readings. Rather it will replace the oldest reading stored 
within the KeyTag with the latest reading so that only the most recent readings are 
maintained in the KeyTag's memory.

If the KeyTag being configured does not support this feature, you will not be able to 
select this setting.”
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Working with batches of 
KeyTags

You may find that at some stage you need perform a similar task on multiple KeyTags, 
whether it is retrieving readings stored within the KeyTags and/or preparing them for 
their next use. The KeyTag Analyser software has been designed to make the effort 
involved with multiple KeyTags as simple as possible.

To retrieve a copy of the recorded readings stored within multiple KeyTags, simply 
insert each KeyTag to download into the Interface cradle. The software will then 
automatically retrieve the recorded data from the KeyTag, save it to disk and then 
display the information for you. Therefore, you will be able to retrieve the recorded 
readings stored from within one or more KeyTags without needing to interact with the 
software and/or computer.

To prepare multiple KeyTags for use you can use the "Wizard..." or the "Configure..." 
wizard, available in the "KeyTag" menu, depending on whether or not you want to 
retrieve and save a copy of any readings recorded within the KeyTags you are about to
use. Simply prepare the first KeyTag(s) as per usual and at the conclusion of the last 
step remove the KeyTag(s) from their Interface Cradle, place the next KeyTag(s) to be
prepared for their next use into an Interface Cradle and click . Therefore, you 
will be able to prepare multiple KeyTags for use with minimal interaction with the 
software and/or computer.

Getting the best from 
your KeyTag

Many users of humidity and/or temperature loggers are used to attaching the logger to
a hook or tie-wrapping them to a monitored object. A wide variety of attachment 
methods can be used with the hole on upper right hand corner of the KeyTag, such as 
bolting the KeyTag in position, attaching it to a packaging strap, using a car-seal for 
security or other means.

The hole is quite strong, so most means of attachment will not compromise the 
structural integrity of the KeyTag. We do, however, recommend that the dead weight 
stress on the hole itself not exceed 5 pounds (2 Kg).
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The sensor for the KeyTag is also very responsive, so we recommend you position the 
KeyTag in a location, where it will not be susceptible to changes in temperature due to 
operational activities. For example, it is not recommended you place a KeyTag beside a
door way, as every time someone passes through the door, the KeyTag will register 
the change of environmental temperature due to the breeze that will be generated by 
the person, which does not necessarily reflect the overall temperature of the 
environment been monitored.

Configuration Profiles

Starting with version 2.2 KeyTag Analyser provides a great way to make the task of 
configuring loggers over and over with the same parameters a lot simpler.

For every logger type multiple configuration profiles can be stored and retrieved later. 
These configuration profiles hold information such as alert limits, logging interval, 
number of readings to record and most of the other parameters you would typically 
enter during configuration.

Configuring a logger with a given profile requires only three steps:

1 Access the "Profiles" function from the KeyTag menu

2 Select the profile you wish to use in the Configuration Profiles main window 

3 Click on configure
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The "Configuration Profiles" window is accessed through the KEYTAG menu by selecting 
PROFILES.

The window that is now displayed gives you an overview of the profiles already 
installed as well as some controls so you can add, edit and delete profiles.

Figure 13: Profile main window

 - Profile grid

 - Profile control buttons

 - Profile storage file path and name

 - Profile file controls

 - Dialogue controls

Profiles Grid
When you first select this feature the profiles grid will be empty (just like above). You 
will fill the grid by adding profiles or importing profiles.

Figure 14: Profiles grid

Profiles from the grid can then be used to configure loggers. A single click on the 
column title will sort the profile using this column. Double clicking on a profile will 
configure all loggers currently in connected interfaces using the parameters stored in 
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the configuration profile. You can select multiple profiles for export or deletion when 
you hold down the CTRL key while clicking, but you cannot edit or apply more than 
one profile at the same time.

Profile Control Buttons
Selecting the "Configure loggers" button will configure all loggers currently in 
connected interfaces using the parameters stored in the configuration profile 
highlighted in the grid (this is the same as double clicking on the profile name).

Use the control buttons to add new profiles, and to edit or delete existing profiles.

Clicking the  button will bring up the "Edit Profile" window. 

Figure 15: New Profile Window

 - Profile name

 - Recorder model

 - Configuration parameters

This window contains all the controls you can find in the configuration window, plus 
one entry field at the top where you need to enter the new name of the profile, and a 
drop down box where you need to select the model type of the logger.

The same window will be displayed when you press the  button. Every entry field 
is now populated with the saved value for this profile. Any entry field can be edited, 
with the exception of the model type.

You can click  to save the profile,  to discard any changes, and also 
bring up the help screen for this window by selecting .
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Profile Storage File Name and Path
The collection of profiles displayed in the profiles grid is saved in a single file on your 
PC, which is called the profile file. This file is typically stored in a folder called "KeyTag 
Configuration Profiles" inside the "My KeyTag Data" folder. Every time you open 
KeyTag Analyser this profile file is activated.

You can select alternative collections by opening different files. This can be useful if for
example you want to keep different profiles for different customers, or you prefer to 
separate and organise your profile collections.

You can click on the  button and select a different profile file. If you have unsaved 
changes you will be asked to confirm if you want to first save these changes. An 
explorer window will then open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You
can then open the new profile file and add, edit or delete profiles as usual. 
Alternatively, you can download an empty profile file template from 
http://www.keylog.nl/download/Blank_Profile.ktp.

Profile File Controls
If you have stored your profiles in different profile files, you can transfer data between 
different files with the import and export buttons.

When you click on the   button, an explorer style window will open. Select the 
profile file from which profiles will be imported and confirm your selection by clicking 
on . All profiles from the selected profile file will be imported into the currently 
active profile. If a profile is imported that has the same name as an already active 
profile, you need to confirm whether you wish to skip the import of this profile or 
overwrite the active profile with the imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking the
 button. An explorer style window will open, where you can enter a new 

profile file name (the file will be created when you press ), or overwrite an 
existing profile. If a profile is exported, and a profile file already exists, you need to 
confirm whether you wish to cancel the export of this profile or overwrite the profile 
file. You can export more than one file at the same time by selecting the desired files 
while holding down the CTRL key.

You cannot amend a profile file by exporting a profile.

Profile Window Controls
Clicking  will store the profile in the location entered above. Clicking on

 will discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:
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Configuration profiles cannot use the date/time start mechanism. If a defined start 
time were to be applied to a profile, this time would most likely have passed by the
time the profile is applied. If you need to configure a number of loggers and you 
want then all to stat at the same time you should use the standard configuration 
screen and the Again button.

You cannot configure one type of logger model with a profile written for another 
model.

You cannot have multiple profiles with the same name.

If you have exported a profile to a profile file, cancelling the main edit window will 
not undo the changes.

If you try to apply a profile to a recorder with a password protected configuration, 
this same password must be provided in the profile. There is no separate password 
confirmation dialogue.

Loggers that can be upgraded to use a download password will automatically be 
upgraded when a profile is applied using this feature. 

Sometimes a logger cannot be configured using a particular profile. In this case one of 
the following errors will be displayed:

"Logger does not support 
advanced alert settings"

You have selected a profile which has separate upper and 
lower alert settings, but the logger you wish to configure 
does not support this. You will need to use a different profile,
or use a different logger if this feature is important for this 
trip.

"Logger cannot record more 
than X readings"

You have selected a profile that requires the logger to take 
more readings than fit into its memory. You will need to use 
a different profile, or use a different logger if this feature is 
important for this trip.

"Password in profile does not
match logger password"

You have selected a profile with a password, and the 
password currently stored in the logger is different. You will 
need to use the normal configuration process to remove the 
password; after that you can use the profile function to 
configure the logger with the new password. If the logger 
does not allow the password to be changed, you will need to 
use a different profile.

"A password cannot be 
applied to this logger"

You have selected a profile with a password, but the logger 
is factory configured so the user cannot change or enter a 
password. You will need to use a different profile that 
doesn't have a password protection, or use a different logger
if this feature is important for this trip.

"Logger only supports 
latched master alarm"

Loggers typically can have a setting applied that allows an 
alarm to reset if conditions go back to within specification. 
Some older KT-108-D loggers do not support this feature, 
and if you attempt to configure such a logger with a profile 
using this setting you will see this error. You will need to use 
a different profile or use a later model KT-108-D if this 
feature is important for this trip.
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"Profile logger type does not 
match"

You are trying to configure a unit with a profile that was 
created for another model. A profile is specific to a logger 
model, so you will need to use a different profile.

"Lease expired. The max. 
number of starts has been 
reached."

You are trying to configure a unit which has no more trips 
left. You will need to use a different logger.

Quickly re-configuring 
KeyTags

You can now configure a KeyTag recorder without first displaying the configuration 
screen. To do this, you can use the "Quick Re-Configure" function from the KeyTag 
menu, and you will see the "Upload configuration" screen where a recorder will simply 
be re-configured with the settings used for the previous trip.

Figure 16: Quick Re-configure option through menu

You can also use the "F6" function key. 

There are certain rules when using this function:

 You can use multiple interfaces. Each KeyTag detected in an interface is re-
configured with the same data used for its previous trip. Recorders do not have to 
be of the same model, and can each have different configuration settings.

 Re-configuration is only possible for recorders which used the "Push button" or the 
"Push button from hibernation" start method for their previous trip. If the 
recorder's previous trip was started by the date/time start method the quick re-
configure option will result in an error message being displayed.

 If a recorder requires a password for configuration you will be requested to provide
this password. If you enter an incorrect password, the configuration process will be
aborted.

 If the KeyTag is still logging when you reconfigure it, you will be asked to confirm 
whether or not you wish to stop the current trip.
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Automatic Re-
Configuration after 
Download

To re-configure a recorder even faster you can now use the "Re-configure with same 
settings after automatic download" option.

When you have enabled this option in EDIT - OPTIONS - AUTOMATION, a KeyTag is 
automatically re-configured with the same settings as the trip just completed once its 
data have been downloaded (see Automation on page 122). You will receive the 
following feedback once the configuration is complete:

Please note this option only works when a KeyTag is automatically downloaded when 
inserted into the interface, i.e. the "Enable automatic download of readings from 
KeyTags" option must be enabled, and the download triggered by inserting the 
recorder into the interface. This does not apply when the KeyTag is downloaded 
through the menu of by pressing F4.

A word of caution: If the KeyTag you have downloaded does not have a 
configuration password and has also finished logging, the only visual feedback on 
the PC will be after the recorder has already been re-configured for a new trip. You 
will only be able to access the data from the trip just downloaded on the PC, but not
within the recorder. Therefore it is important you make sure the file location for 
storing data is always accessible to avoid loss of data.

Hibernation - Prolonging 
battery life

If your KeyTag is not going to be used for extended periods of time, you should set it 
to "Hibernation". While in "Hibernation" the KeyTag will consume minimal power, 
which will extend the battery life when compared with leaving an idle KeyTag 
operating.

While a KeyTag is in "Hibernation" it will:
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 Not record and store any new readings.

 Not activate the Alert and OK lights.

 Not respond to the START MARK button being pressed.

The only exception is when the KeyTag has been configured for 'Push button start 
from hibernation' in the configuration screen. In this case pressing the START MARK 
button will 'wake' the product and commence logging according to the configured 
settings. Not every model supports this feature.

To 'wake' a KeyTag from "Hibernation" to normal operation go through the usual 
process of preparing it for next use (see "Preparing KeyTag(s) for use" on page
31).

To set a KeyTag to "Hibernation", select HIBERNATE... from the KEYTAG menu.

You can also use the F5 function key.

The following example illustrates using the "Hibernation" feature.
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In this screen you will see one of the following pictures next to each of the items in the
list:

 (no picture) indicates the KeyTag is still in the process of being hibernated.

  The KeyTag was successfully set to hibernation.

  The software was unable to set the KeyTag to hibernation.

Once a KeyTag has been successfully set to "Hibernation" it should be removed from 
the Interface Cradle before pressing any other button. As soon as the software 
communicates with a KeyTag in "Hibernation", (for example through automatic 
download it will be returned to normal operation.

The extent to which the Hibernation will prolong the battery life of a KeyTag may vary 
between different models and versions of KeyTag products. Some KeyTag models may 
not support Hibernation.
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For most KeyTags you will want to view the recorded information once a trip has been 
completed. For this, you can use the KeyTag Analyser software and an Interface Cradle
to transfer the information from the KeyTag to a PC. The software will automatically 
save any downloaded trip information retrieved from a KeyTag to your disk drive so 
that you can view the information and archive it.

This chapter explains how you can retrieve the recorded information and have the 
software display it to you on the screen in a meaningful way.
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Getting results from 
KeyTag

KeyTag products store all readings in non-volatile memory. You can retrieve the 
recordings as many times as you require, as long as the recorder is not re-configured. 
The process of retrieving data stored within a KeyTag does not in itself erase the data 
from the KeyTag's memory, however if you have turned on the "Automatically re-
configure..." option you will no longer be able to access the data inside the recorder 
once this process has finished; rather you must rely on the stored file to access such 
data.

If the KeyTag is currently recording while you retrieve the information, it will continue 
to record without interruption. If the recorder is in the process of taking a log you may 
see a slightly longer download time as communication pauses to allow the log to be 
taken.

There are three ways to retrieve the recorded results from a KeyTag:

 Slot the KeyTag into the interface cradle while the KeyTag Analyser software is 
running (this can be in the background, or even minimized). If the automatic 
download feature is enabled, the software will automatically retrieve the recorded 
readings, save the information to your disk drive and display the information to 
you. While the software is automatically retrieving the readings you will see an 
animation, similar to the following picture.

You can also enable the option to automatically re-configure the KeyTag with its 
current settings (see Automatic Re-Configuration after Download on page
61).

 Click DOWNLOAD... from the KEYTAG menu.

You can also press the F4 function key.

 Click the KeyTag icon ( ) on the toolbar or click on WIZARD... from the KEYTAG menu.

The wizard will guide you through the necessary steps to retrieve the readings 
stored in the KeyTag and then offer to prepare the KeyTag for its next use. If you 
do not need to configure the KeyTag at this time you can cancel the process, 
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however if you do not intend to configure units directly after downloading you may 
find it quicker to use the previous option.

Note: While the wizard is visible the "Automatic download" feature will be temporarily 
disabled. You will not be able to access any of the Wizards while an "Automatic 
download" is in progress.

Saving KeyTag Data

Saving KeyTag Data files
Every time you download a KeyTag Recorder to your computer the data are 
automatically saved to a file with a *.ktd file extension (KeyTag Data). This type of file 
is unique to KeyTag data loggers and can only be read by KeyTag Analyser software.

You can customise the conditions for which the file is generated in the EDIT - OPTIONS 
window:

 You can determine the file's name by specifying the key details about the logger it 
was downloaded from (File Name on page 137)

 You can decide if existing files with older data should be overwritten or kept 
(Uniqueness on page 140)

 You can automatically have files sent to e-mail recipients and FTP sites 
(Automation on page 122)

 You can decide which additional other file formats are created (Exports and 
Reports on page 141)

You can also save all or part of the data in other files to make them accessible to other
users (Selected KeyTag files on page 68 and PDF files on page 71).

Please refer to the respective sections in this user guide for more information.

Saving a Multi Chart file
If the main KeyTag Analyser window currently displays a Multi Chart as explained in 
Combining charts onto a single chart (on page 92), you can save the current 
configuration by clicking on the  toolbar icon or selecting SAVE from the File menu 
(on page 150). Select a file name and location for your Multi Chart file. The file 
extension for Multi Chart files is "*.multi".

A Multi Chart file does not contain any recorded data. Instead, it contains a collection 
of information that describes which data files need to be opened, and in which relation 
to each other the data inside these files should be displayed, such as chart colors and 
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time offset when Shifting chart start times (see "Combining charts onto a single 
chart" on page 92).

Therefore, if any of the data files referenced in a Multi Chart file are renamed, deleted,
or moved to a different folder, this Multi Chart file will display error messages.

A Multi Chart file must be saved in the same folder as the individual data files. It is not 
sensible to store relative path information inside the file, as it would make it difficult to 
e-mail a Multi Chart file if the recipient would have to re-create the exact folder 
structure as the sender for the file to be displayed.

Any annotations added to the Multi Chart display are saved in a separate annotation 
file with the file extension ".anno". This file must be located in the same folder as the 
Multi Chart file to be included in the Multi Chart display.

To open a previously saved Multi Chart configuration file, click on the  toolbar icon 
or select OPEN... from the File menu (on page 150), then select the "*.multi" file to be 
opened.

To save a Multi Chart file under a different name, select the Save As... command from
the File menu (on page 150) and enter a new file name.

Note: You can export a Multi Chart file as a PDF, but not in any of the other export file 
types.

KeyTag indicator products such as the TICT or TIC20 do not have date/time related 
readings and therefore do not appear on the multichart.
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Selected KeyTag Data files (*.sktd)
Users can save a file, which when opened again, will only display a selected time 
window of the recorded data. The time window of this "Selected KeyTag Data" file is 
defined through the zoom settings of the currently active tab, or can be entered in the 
dialog box displayed when the "Save as..." command from the File menu (on page
150) is chosen with 'Selected KeyTag Data (*.sktd)' as the file type.

Select a file name and location for your file.
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The chart of this file, which contains pre-start readings, has been zoomed to show only
a small proportion of the readings:

The window slider shows there are still readings earlier and later than the displayed 
data.

When saved as a *.sktd file, it will be automatically re-opened and now only displays 
the previously zoomed readings. You will note that the pre-start readings are no longer
displayed and you cannot zoom out or display any readings before and after the 
selected time frame.

Note: Those readings which are no longer displayed are still present in the file. Any 
*.sktd file can be saved as a *.ktd file, and when re-opened, all readings taken by the 
recorder during this trip will become available for viewing.

This can also be achieved by simply re-naming the file from *.sktd to *.ktd.

Files with a *.sktd extension cannot be read by versions of KeyTag Analyser earlier 
than 2.0, they can however be read once renamed to *.ktd.
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*.sktd files can also be opened directly from e-mail attachments or by double clicking 
the file in Windows Explorer, as the installer for KeyTag Analyser registers this file 
extension and associates it with KeyTag Analyser.

For KT-108-D and KTL-208-D the *.sktd files no longer contain the summary tab.

Saving a file for use in spreadsheets
Occasionally you may wish to export a KeyTag data file so you can analyse it in more 
detail using a spreadsheet program such as Microsoft™ Excel. You can choose from 
different options to achieve this:

 You can use the FILE - SAVE AS command from the menu, and select the *.csv option.
You can include pre-start data and also include summary information about the 
recorder by selecting the corresponding tick boxes.

Figure 17: Save file in CSV format

CSV files can be read by most spreadsheet programs. 

Please note that files created by KeyTag Analyser may not always be true CSV files 
(Comma Separated Values), as they use the list separator from the Windows 
operating system. It does however mean the file can be opened with MS Excel 
without going though the data import facility. To create a true CSV file select "Use 
custom list separator" and enter a comma in the adjacent field. You can also use 
the custom list separator to generate files for applications which require other list 
separator characters.
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 Select the Data tab and press CTRL-C or choose EDIT - COPY from the menu. Open 
an empty worksheet in your spreadsheet program and select CTRL-V or choose 
EDIT - PASTE from the menu. The data will be pasted in the cells and you can save 
the file in the format of your spreadsheet program.

 Automatically export the data into a CSV file when a logger is downloaded. Please 
see Exports and Reports on page 141 for further details.

PDF files
KeyTag Analyser can save the currently active KeyTag data window to a PDF file. One 
single file will be generated which contains chart images, summaries and a data list.

PDF files can be generated automatically, or by selecting "Save as" from the File 
menu (on page 150). Select a file name and location for your PDF file. Automatic 
generation of PDF files is enabled in the section about Exports and Reports on page
141. Here you can also define the composition of the PDF file.

Click the  button; the following dialogue window is displayed, allowing you 
to select which content of the PDF file will be created.

Figure 18: Setting the PDF properties
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Note: Only one single Data listing will be created. Depending on which sections are 
enabled, pre-start only, chart only or all readings will be included.

Note: The report page is always included in the PDF. For display loggers, the day 
summary will also be always included.

Each section can be identified by its heading. If a chart is zoomed, the PDF file will also
contain a zoomed setting.

Figure 19: PDF sample pages
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Analysing the results

Data are analysed in file windows, which appear inside the main KeyTag Analyser 
window. Each file window displays the data of a single logger and has a series of tabs 
along the bottom. Clicking on a tab changes the way the information is displayed; 
different windows can display different tabs.

You can activate Multi Chart display, and all open file windows are combined into a 
single window. You can find more information about this feature in Combining 
Charts into a single chart on page 92.

The different ways to display the information in the file windows are:

Tab selected Information displayed

Report Tab A summary display of the downloaded data, including a 
summary of the important trip information and an overview 
graph.

Chart A display of the data in a humidity and/or temperature versus 
time chart.

Data A listing (spreadsheet style) of the time versus humidity and/or 
temperature data.

Summary A summary of the data, including averages, ranges, alert 
results, KeyTag identification data, and other information.

Day Summary A summary of the day statistics for display loggers and indicator
products.

Pre-Start Chart Same as the "Chart", but limited to only show pre-start 
readings.

Pre-Start Data Same as the "Data", but limited to only show pre-start readings.

Pre-Start Summary Same as the "Summary", but limited to only show pre-start 
readings.

All Chart Same as the "Chart", but showing both regular and pre-start 
readings.

All Data Same as the "Data", but showing both regular and pre-start 
readings.

All Summary Same as the "Summary", but showing both regular and pre-start
readings.

The most used tabs will typically be the report tab or the chart tab, as the information 
displayed in either of them gives an instant overview of the data, whether just 
recorded and downloaded from a KeyTag or retrieved from previously stored data files.

Results from KeyTag 73



Pre-start logging is a feature that allows a KeyTag to record readings between the time
it is configured and the time it is started via the push button method, meaning data 
are collected even if a user accidentally forgets to start the recording. You can find out 
more about this feature in pre-start logging on page 53.

In some cases not all tabs previously described will be displayed. You may for example
see only Report, Chart, Data and Summary, if the KeyTag has been configured not to 
record any pre-start data.

Note: Indicator products such as the TICT or TIC20 only display the Report and Day 
summary tabs. 

The following sections describe each type of information display (Report, Chart, Data, 
Summary and Day Summary) in more detail.

Chart Display
Clicking on the CHART tab presents the information in the file window as a 2-D line chart
with markers. When you first start KeyTag Analyser, this tab is activated by default, 
but you can change this in the OPTIONS.

Figure 20: Chart sample

 - Chart title

 - Above alert area

 - No alert area

 - Graph line

 - Below alert area

 - Time line

 - Time zone

 - Chart Statistics

 - Tabs

 - Chart legend
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You can see how humidity and/or temperature changed over time. If you want to see 
parts of the graph in more detail, you can zoom in and display a smaller section of the 
data. Move the cursor to the upper left corner of the area you wish to magnify, hold 
down the left mouse button and move the cursor so it covers the area you wish to see:

When you release the left mouse button, the the area highlighted now fills the 
window:

Figure 21: File window with zoomed chart

 - Chart sub-title

 - Mouse cursor on data point

 - Tooltip

 - Marker

 - Download mark

 - Inspection mark

Depending on the zoom level not every data point may have a marker displayed. 
KeyTag Analyser intelligently adjusts the display of markers so the graph line is still 
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visible. These markers can also be turned of, and their appearance can be altered. You
can learn more about this is the Charts Section (see "Charts" on page 119). You can 
also see a number of other marks. Inspection marks are recorded in the KeyTag's 
memory each time its START MARK button is pressed. Each inspection mark is 
numbered and can be identified by counting the number of marks on the Chart display.
Download marks are recorded in the KeyTag's memory each time it is downloaded to a
PC.

When the mouse pointer is moved over the chart, a tooltip is displayed near the mouse
pointer (as shown in the example). It displays the reading closest to the mouse pointer
position. If the readings are very close together, you may want to zoom in further and 
then inspect individual readings with the help of tooltips.

The tooltip will always show date and time of the recording, even when elapsed time is
chosen for the x-axis display. This will allow you to get the date and time information 
quickly without having to change the setting in the options for Charts (on page 119).

You can add annotations (Chart annotations on page 80) and a subtitle (Chart 
subtitle on page 82) to the chart.

The chart area displayed in the window can now be copied to the clipboard by either 
selecting a picture of the highlighted area can be placed on the clipboard. This picture 
can be then be pasted into any Microsoft Windows® application. For example, if you are
writing a letter and want to illustrate a point based on chart data from a KeyTag, you 
can paste the picture of the chart directly into the letter.

You can change the appearance of all charts permanently by changing the options in 
Charts (on page 119). If you wish to temporarily change the appearance of only a 
single chart in the file window you can use the context menu, which is accessed by 
right clicking while the mouse cursor is in the graph area.

Figure 22: Context menu in chart tab

 - Appearance controls

 - Shade controls

 - Zoom controls

 - Annotations

The appearance controls influence general items on the chart, such as turning on and 
off marks and grid lines; these can be useful for finding information on the chart 
easier. Clicking on an enabled item will disable it and vice versa.
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The shade controls can be used to highlight the alert and non alert areas of the chart 
for easier identification.

You can use the zoom controls to define which part of the data is displayed on screen
(see Zoom Control on page 77) and the Annotation menu to display text on the chart 
(see Chart annotations on page 80).

Zoom Control

Manual Scaling

You can zoom into any detail of the chart (until you only see a single reading) by using
your mouse as described. You can, however, also use direct data input to have a more 
refined control over the data to be displayed, such as temperature and humidity scale 
or the range of readings by time and date.

Call up the context menu by right clicking anywhere on the chart area and select 
MANUAL SCALING. The following dialog will be displayed:

Figure 23: Manually scaling a chart

You can select:

 Range of sensor; the chart is zoomed to the minimum and maximum values for 
each sensor. These values are dependent on the recorder model.

 Range of readings; the chart is zoomed to the minimum and maximum reading 
values.

 Manual Scaling; this option lets you specify the date/time range, temperature and 
humidity ranges (if applicable) for the chart display. Initially the dialog shows the 
current zoom settings.

Click  to apply your selected settings. 

To return to the previous zoom level, use the Zoom Out ( ) command in the Edit 
menu (on page 153), on the toolbar (see "Toolbar commands" on page 158) or by 
right clicking anywhere on the graph area and selecting ZOOM OUT in the context menu.

By default, each chart is initially displayed zoomed to the range of readings. This 
default setting can be changed in the Options dialog (see chapter “Charts (on page
119)”).

Inspection and download mark zoom

You can also zoom directly to certain parts of the chart by using the inspection mark 
zoom icons on the toolbar and in the context menu.
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Zoom out

Zooms out one level of the chart in the currently active window. If you are 
displaying a chart and this function is not available, then all available data are 
already being displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the oldest reading 
recorded and the first inspection mark that exists in the data. If this function is
not available then there are no inspection marks in the data currently being 
displayed.

The next two commands will not be available until this command is activated.

Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the
first inspection mark currently being displayed and the previous inspection 
mark.

This function is disabled when either the oldest reading is already being 
displayed, or the "Zoom to inspection marks" function has not been activated. 

Next inspection mark group

This zooms the chart so readings are shown which were recorded between the
last inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being 
displayed, or the "Zoom to inspection marks" function has not been activated.

In addition to zooming out and manually scaling the chart the context menu gives you 
some additional functions not available through the toolbar.

From first reading to first inspection/download mark

This zooms the chart so readings are shown between the oldest reading recorded and 
the first inspection mark or download mark that exists in the data. This different from 
the "Zoom to inspection marks" feature as it also evaluates download marks. You can 
use this function to look at the first set of data where a logger is downloaded more 
than once during a trip, for example in a cold chain transport where goods are 
transferred from a cargo ship to a distribution truck and you are only interested in the 
shipping portion of the trip.

From last inspection/download mark to last reading

This zooms the chart so readings are shown between the last inspection mark or 
download mark and the newest reading in the data. This is different from the "Zoom to
inspection marks" feature as it also evaluates download marks. You can use this 
function to look at the last set of data where a logger is downloaded more than once 
during a trip, for example on a distribution truck which has multiple drop off points and
you are only interested in the last portion of the trip.

If either of the two menu points are greyed out you are either already looking at this 
part of the data, or there are no inspection or download marks present.

78 KeyTag User Guide (2.3) 



In the General section of the Options you have the opportunity to define either of 
these two settings as the default when files are opened or recorders are downloaded. 
You can see in the section General Settings (on page 117) how this is applied.
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Chart annotations

To include additional information in your chart you can add chart annotations. These 
will be displayed and printed with your chart. Click the right mouse button at the 
location where you want to add the annotation. The context menu will open, allowing 
you to select ANNOTATIONS.

Select ADD, enter the annotation text and click . The annotation will be 
displayed in the chart. When you zoom the chart display, the annotation will stay on 
screen as long as the point to which the annotation was attached is also displayed.

To edit an annotation, click the right mouse button while the cursor is at the 
annotation's location and select EDIT from the annotations menu. Edit the text and click

 to display the edited annotation.
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To delete an annotation, click the right mouse button while the cursor is at the 
annotation's location and select "Delete" from the annotations menu. The annotation 
will be deleted. To delete all annotations, select DELETE ALL.

Selecting the "Show" command from the Annotations popup context menu will show or
hide all of the annotations on the chart.

To save the annotations, click the  toolbar button or select the SAVE command from 
the File (see "File Menu" on page 150) menu. The annotations will be saved in a file 
with the same name as the data file and the file extension ".anno". 

When saving annotations in Multi Chart mode, the software will ask you to specify a 
file name for the Multi Chart configuration, if you are saving this configuration for the 
first time.

Note: The contents of the original file are not changed. If the ".anno" file is 
accidentally deleted, the annotations will no longer be displayed, but the recorded data
will still be intact.
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Chart subtitle

The chart subtitle is displayed and printed underneath the chart title.

To edit the subtitle, right-click on the area above the chart and select "Edit Chart 
Subtitle" from the popup context menu.
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Enter or modify the text, then click  to display the edited subtitle. To remove 
the subtitle, delete the text in the Edit Chart Subtitle dialog and click .

To save the chart subtitle click on the  toolbar icon or select the Save (see "File 
Menu" on page 150) command from the File (see "File Menu" on page 150) menu. 

If the KeyTag Analyser application is in Single Chart mode, the subtitle (and 
annotations) for the currently active chart will be saved in a file with the chart file 
name and the file extension .anno.

In Multi Chart mode, the subtitle is saved in the Multi Chart configuration file (file 
extension .multi). If you are saving the configuration for the first time, you will be 
asked to specify a file name for the Multi Chart configuration.
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Report Display
The Report display provides a convenient and quick way of seeing all important 
information for a trip in one single screen.

Figure 24: Sample report tab

 - Download and time zone information

 - General information

 - Alarm pass/fail

 - Configuration information

 -Trip information

 - High Alarm information

 - Low Alarm information

 - Receiver notes

 - Graph area

 -  Event information

The graph area shows a slightly smaller version of the chart. The zoom controls are 
linked to the chart tab. If you zoom in to a particular area on the report's chart area, 
the same area will be displayed in the chart tab and vice versa. You can use the same 
zoom controls as in the chart, with some exceptions to the context menu controls.

Figure 25: Report tab context menu

 - Grid control

 - Zoom control

 - Receiver notes

 - Annotations

Some of the appearance and shade controls are no longer available, however the 
remaining grid and zoom controls work the same as they do in the chart tab on page
77, and so does the annotation function on page 80. Annotations added in the chart
tab will be displayed in the report chart and vice versa.

When you select RECEIVER NOTES you will be able to add a text field that is then 
displayed in the report's Receiver Notes section every time the file is opened. 
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These notes are stored in the "*.anno" file, which also holds the chart annotations. 
This file must be present in the same directory as the "*.ktd" file.

If you enlarge the width of the window sufficiently, the report will be displayed in 
landscape format.

Figure 26: Report tab in landscape format
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The report will have a different look for TIC20 and TICT products, since they do not 
store continuous temperature data:

Figure 27: Sample report tab for TIC20

 - Download and time zone information

 - General information

 - Alarm pass/fail

 - Alarm Configuration information

 -Trip information

 - Alarm information

 - Receiver notes

 - Alarm trigger events

 - Temperature bars

 -  Graph area with alert shading
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Data Display
When you click on the data tab the readings are displayed in a list in chronological 
order from top to bottom, also showing index, date & time and elapsed time. On the 
list you can also identify any special marks attached to the reading, such as download 
marks (identified through purple background) and inspection marks (identified through
red background). The colour of the text identifies if a reading has been above the 
upper alert value (red), below the lower alert value (blue) or within specification 
(black). You can scroll through the readings with the arrow, page up/down, home and 
end keys, or use the mouse to move the readings with the scroll bar.

Figure 28: Sample data grid

 - List header row

 - Reading with download mark

 - Reading below lower alert value

 - Reading with inspection mark

 - In spec readings

 - Reading above upper alert value

 - Scroll bar

The data tab will only display those readings shown on the corresponding chart. If the 
chart is zoomed in, the data tab gives access to only the zoomed readings. You cannot 
use the scroll bar or arrow keys to display readings before or after the currently 
zoomed readings.

The list grid can be copied to the Windows clipboard and pasted into other windows 
applications such as spreadsheets, including the list header row. When the 
corresponding chart is zoomed in, only those values will be copied.

The zoom controls available for the chart tab are inactive in the data tab.
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Summary Display
The summary tab offers a brief statistics overview of some of the important trip data. 
You can customise the statistical data you wish to include in this tab in the Options 
dialogue for the Summary Statistics on page 118.

The first section shows the data for the complete trip, regardless of whether or not the
chart is zoomed in. The second section is only displayed if the chart is zoomed in, and 
displays the statistics for only the zoomed readings.

 - Statistics summary for entire trip

 - Statistics for zoomed readings

If there are readings beyond the limits of the sensor within the time interval displayed, 
the statistics for this interval will show "**".

The zoom controls available for the chart tab are inactive in the summary tab.
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If inspection marks are present in the data, statistics summaries for each of the 
inspection mark groups in the data can be seen amended to the end.

 - Statistics summary for first inspection mark group

 - Statistics summary for second inspection mark group

 - Statistics summary for third inspection mark group

The list grid can be copied to the Windows clipboard and pasted into other windows 
applications such as spreadsheets, including the list header row.

Day Summary Display
The day summary tab is displayed for KeyTags with an integrated statistics memory.
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KeyTag recorder products with display

For these recorder models the day summary display shows the history of up to 30 
days, arranged into 24 hour periods, with information about maximum and minimum 
values for the day, and if alarms have been triggered on those days.

Figure 29: Day summary display

 - Day summary header row

 - Summary grid

 - Alarm marker

 - Above Alarm level marker

The Day Summary grid can be copied to the Windows clipboard and pasted into other 
windows applications such as spreadsheets, including the header row.
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KeyTag Indicator products with display

These indicator products have multiple alarm levels. Time above or below each alarm 
level is displayed, with information about maximum and minimum values for the day, if
alarms have been triggered on those days and how much time elapsed on that day 
until the alarm was triggered.

Figure 30: Day summary display

 - Day summary header row

 - Alarm duration and trigger time

 - Summary grid

 - Total time monitored

The Day Summary grid can be copied to the Windows clipboard and pasted into other 
windows applications such as spreadsheets, including the header row.
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Combining charts onto a 
single chart

To overlay multiple charts in one view, select the Multi Chart ( ) command. All charts
that are currently open will be displayed together. Additional files opened while in Multi
Chart mode (including data downloaded from KeyTags) will be added to the display.

Each of the individual charts will be displayed with a letter symbol to allow you to tell 
them apart. The legend contains an entry for each chart showing the chart name and 
the corresponding letter.

You can change the background color for the Multi Chart display through the Charts 
(on page 119) section in the Options (see "Customising the software" on page 115) 
Window. 

To remove charts from the Multi Chart display, use the Single Chart ( ) command to 
switch to Single Chart mode, then close the files you don't want to display. Select the 
Multi Chart ( ) command to switch back to Multi Chart mode.
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You will notice that the Data and Summary tabs are not available in the Multi Chart 
display. If you require additional information about the chart data, activate the display 
of the desired statistics on in the Chart Statistics (on page 118) section in the 
Options (see "Customising the software" on page 115) Window. The chosen values 
will be displayed separately for each chart.

You can also view Min, Max and Average Charts (see "Special Chart Tabs" on page
97), and select other options.

Changing Chart Colours
By default, all charts in the Multi Chart display are displayed in the colors specified in 
the Charts (on page 119) section within the Options (see "Customising the software" 
on page 115) Window.

To change the display color of individual charts/sensors, move the mouse pointer over 
a chart until the tooltip is displayed. Right-click, then select "Change Chart Color" from 
the popup context menu. 

Select the desired colors for the chart readings and markers in the color selector 
boxes. To restore the default color (as specified in the Charts (on page 119) section 
within the Options (see "Customising the software" on page 115) Window), select the
"Restore Defaults" command.

Shifting chart start times
For easier data comparison, chart start times can be shifted in Multi Chart display. 
There are two ways to shift a chart along the time axis:

Results from KeyTag 93



1. Move the mouse pointer over the chart until the appropriate tooltip is displayed. 
Right-click, then select the "Shift Chart" command from the popup context menu. This 
will cause the following dialog to be displayed, where the new start time and date can 
be entered, or the chart can be revert to its original date/time by selecting the 
"Original start time" button. Click the OK button to display the change.

2. Press and hold the CTRL key, left-click on the chart you would like to move, and 
drag the chart to new the position.

An additional time axis is displayed for each shifted chart indicating the corresponding 
time in relation to the original start time.
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Note: Shifting a chart will not change any of the original recorded data, only the 
location the data is displayed in relation to other charts within the Multi Chart display 
will change. 

Aligning Charts
Select "Align Charts" from the popup context menu to automatically align all charts in 
the current Multi Chart window. 

The charts are aligned to the earliest start time:

- "Chart" tab: All start times are aligned.

- "Pre-start Chart" tab: All charts with Pre-start readings are aligned to the earliest Pre-
start reading.

- "All Chart" tab: Charts are aligned to the earliest reading (Pre-start reading if any 
Pre-start readings have been recorded for the chart).

Every chart is assigned a different colour and a time axis is displayed to illustrate the 
original start time. You can display the elapsed time instead of the date/time by 
selecting the "Elapsed Time" option in the Chart Options dialog (Charts (on page
119)). 
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Aligning charts in one tab will also influence how these charts are represented in the 
other tabs. If for example you select "Align Charts" in the "Chart" tab, and switch to 
the "All Chart" tab, you will notice that the charts are now aligned at a new origin, with
all pre-start readings to the left and all readings to the right of this origin. The charts in
the "Pre-start" tab are aligned with the last pre-start reading to the right.

To revert to the original start times for all charts, select    in the toolbar to switch to
Single Chart mode, then switch back to Multi Chart mode with .
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Special Chart Tabs

When you select the average tab  command in the toolbar, up to three additional 
chart tabs will be shown, with the Chart Average tab highlighted:

These chart tabs display graphs calculated from the "Chart", "Pre-Start Chart", and "All
chart" tabs and show minimum, maximum and average value graphs. Changes in 
either of the three original data displays, such as adding a new file and aligning or 
shifting charts, result in a re-display of the corresponding "Min/Max/Average" tab, e.g. 
if one of the charts in the "Pre-Start Chart" is shifted, the "Pre-Start Min/Max/Average" 
chart would redraw showing graphs based on the updated values.

You can annotate these special chart tabs in the same way as other chart tabs; such 
annotations will be visible in the other chart tabs and are stored with the multi chart 
when saved.

Please note that following behaviour applies to these special chart tabs:

 Zoom settings will not be transferred to the "Average" tabs.

 Download marks and inspection marks will not be displayed in the "Average" tabs.

 Non-validated readings and re-calibrated readings will not be displayed with the 
special attributes, even if set in the options. If you have chosen to "show non-
validated readings", they are included in the minimum/maximum/average 
calculations, otherwise not.

 To avoid memory overflows there are some restrictions regarding the maximum 
allowed time span of the charts in a multi-chart. These restrictions vary with 
logging interval, should you try to add a chart outside the allowed range following 
dialogue box will appear:

In this case the multi chart will disassemble, so you can close the window whose chart 

you no longer want to display, and re-assemble the multi-chart by clicking on .
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 If one or more of the charts have sections with readings outside the KeyTag's 
sensor range, KeyTag Analyser is unable to calculate the minimum, maximum and 
average values, and those sections of the graph will not be displayed. This will 
likely result in a "broken" graph line, regardless of whether "show readings beyond 
specifications" in the Charts (on page 119) section in the Options (see 
"Customising the software" on page 115) Window is enabled or not.

 Due to the large number of calculations performed in this feature, specifically when
opening large numbers of charts spanning long periods, having the average tabs 
displayed can occupy large amounts of memory and run slow. Therefore we 
recommend only turning the feature on when required.

Clicking on the highlighted average tab  command will turn the average tabs off. 
Selecting the single charts  command in the toolbar while the average charts are 
active will disassemble the multi chart, and when switching back to multi chart the 
average tabs will be displayed again until turned off.

Behind The Scenes

To create some meaningful results, KeyTag Analyser uses a special trend line process 
to calculate the minimum, maximum and average values across multiple charts, rather 
than a histogram. It is important you understand this mechanism, so you can interpret 
the displayed readings correctly.

This is an example of two KeyTags, one with a 5 minute log interval (A) and the other 
(B) logging every 2 minutes.
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Before the data are displayed in an average tab, KeyTag Analyser normalizes every 
chart's readings so they fall in line with the logging interval of the KeyTag with the 
shortest log interval, in this case unit (B). It does not shift any charts, but rather 
calculates a theoretical value for those reading times by linear interpolation. 
Interpolation determines probable environmental conditions, i.e. what the KeyTag 
would have recorded if taking a reading at that time.

Without this method, it would not be possible to compare KeyTags with different log 
intervals, or units that have the same log interval, but were started at different times.

Starting with the earliest time present in the chart, a value is created for each KeyTag 
as if it had recorded a log at that time. It is those values that are used to calculate and
display the minimum, maximum and average charts.

As a result of this process, absolute values for minimum and maximum may not always
be shown if they do not fall on normalized times, as seen in the example at 10:35 - 
despite 21ºC being the maximum it will not be displayed as it is not a normalized 
value.

Note: The charts in above example are based on KeyTags started at the same time. If 
unit (A) had been started earlier, depending on the start time unit (B) may also have 
its readings interpolated. To ensure the chart with the shortest log interval always has 
its real values shown, please use the Aligning Charts (on page 95) function from the 
context menu. 
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Automatically calculated 
statistics

When a file is displayed either from downloading or from calling up a stored data file, 
the software will automatically calculate and display some statistics of the recorded 
data. These statistics are shown on the corresponding Summary tab and are also 
calculated for each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the sensor, the values 
for Average Reading, Standard Deviation, and Mean Kinetic Temperature will not 
displayed for the relevant time interval. 

Average Reading
The Average Reading is the arithmetic mean of the sequence of data points. It is 
calculated by adding all the data point values together and then dividing the total by 
the number of data points. Mathematically this formula can expressed as illustrated in 
the following picture:

Where:

av the calculated arithmetic mean

n the number of data points to include in the calculation

ti a data point to include in the calculation

For example, if there were 5 data points to calculate the arithmetic mean of and they 
were, 12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by clicking Options 
from the Edit Menu, then navigating to the Summary or Chart Statistic section, 
highlighting Average Reading and clicking on the  button.

Confirming this dialogue with OK will set the number of decimal places to the number 
selected in the drop down box. 
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Standard Deviation
The standard deviation is a useful measure for determining how spread out the 
readings are from the arithmetic mean (Average Reading). Most controlled 
environments typically try to keep the environmental conditions at a stable and 
consistent humidity and/or temperature. The standard deviation can be used to help 
indicate how stable the environmental conditions were maintained. One standard 
deviation (sometimes expressed as "one sigma") away from the mean, positive or 
negative represents approximately 68 percent of all the readings. Two standard 
deviations, or two sigmas, away from the mean represents approximately 95 percent 
of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard 
deviation was 2.3°C, then approximately 68% of the readings were between 48.3°C 
and 52.9°C, 95% of all the readings were between 46.0°C and 55.2°C and 99% of the 
readings were between 43.7°C and 57.5°C. Further more, if all the readings were 
recorded over a span of 1 day (24 hours) then the temperature was between 48.3°C 
and 52.9°C for approximately 16 hours and 19 minutes during the recorded period of 
time.

KeyTag Analyser allows the calculation of sample or population based standard 
deviation.

Figure 31: Sample based standard deviation Figure 32: Population based standard deviation

Where:

s the calculated sample based standard deviation

sN the calculated population based standard deviation

n the number of readings to include in the 
calculation

av the calculated arithmetic mean

ti a reading to include in the calculation
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The number of decimal places displayed can be set to 1, 2 or 3 by clicking Options 
from the Edit Menu, then navigating to the the Summary or Chart Statistic section, 
highlighting Standard Deviation and clicking on the  button.

Here you can also set whether the standard deviation should be sample based or 
population based.

Confirming this dialogue with OK will set the number of decimal places to the number 
selected in the drop down box and the calculation method.

For a more detailed explanation of the various ways to calculate standard deviation 
please consult the relevant literature related to statistical and probability calculations.
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Mean Kinetic Temperature
Some products and materials have accelerated rates of degradation at higher 
temperatures. For example, perishable food items, pharmaceutical products and many 
forms of bacteria can grow/degrade exponentially as the environmental temperature 
increases. Mean kinetic temperature is a calculation that accommodates the non-linear 
thermal effect temperature can have on products. Mean kinetic temperature is 
represented as the equivalent temperature the product was thermally subjected to 
during the period of time the various temperature reading were recorded.

Mathematically the formula for calculating the mean kinetic temperature can expressed
as illustrated in the following picture:

mkt Mean kinetic temperature, in degrees Celsius

the activation energy

 R the universal gas constant, which is 0.0083144 KJ/mol K

 n the number of data points to include in the calculation

 ti a data point to include in the calculation, in degrees 
Celsius

For example, if there were 5 data points to calculate the mean kinetic temperature of 
and they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic 
temperature would be 14.9 degrees Celsius using the default H.

By default KeyTag Analyser uses an activation energy value of 83.144 KJ/mol for the 
calculation.

You can select a custom value for H by clicking Options from the Edit Menu, then 
navigating to the the Summary or Chart Statistic section, highlighting Mean Kinetic 
Temperature and clicking on the  button.

 

Confirming this dialogue with OK will use the default value or the entered custom value
as selected.
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Charts and the Statistics pages will display the custom H parameter if it is different to
the default value:
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Degree Minutes
There are some products and materials that exist which can change their 
characteristics and/or degrade if they experience temperatures which are not within 
ideal conditions for long enough. For example, some products may experience freezer 
burn if they experience an extremely cold condition or experience a colder than ideal 
temperature for long enough period of time. Other products for example, ice cream, 
change their characteristics if they experience temperatures which allow it to melt. The
KeyTag Analyser will automatically display the results of two separate Degree Minutes 
calculations. The result of the first Degree Minutes calculation displayed will be based 
on the readings that were recorded below the ideal conditions and the result of the 
second Degree Minutes calculation displayed will be based on the readings that were 
recorded above the ideal conditions. The ideal conditions used in the calculation of the 
Degree Minutes formula are based on the upper and lower alert values that where 
configured when the KeyTag was originally prepared for use.

Mathematically the formula for calculating the degree minutes above alert can be 
expressed as illustrated in the following picture:

Where:

degmin Total Degree Minutes spent above/below the alert 
threshold.

ti The temperature that was above/below the alert threshold.

a The alert temperature threshold.

s The duration of time, in minutes, the temperature was 
sustained.

For example, if there were 5 data points to calculate the degree minutes of and they 
were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were 
recorded at 2 minute intervals and the high alert temperature threshold was 12.6 
degrees, then the degree minutes temperature above the upper alert threshold would 
be 22.6 degree-minutes.
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Displaying statistics

The statistics displayed on the Summary tab can be configured in the Options dialog. 
Refer to the chapter "Summary Statistics on page 118". By default, all statistics are 
displayed on the Summary tab.

Statistics can also be displayed on the chart, underneath the legend. See chapter 
"Chart Statistics (on page 118)" for more information about configuring the chart 
statistics.

If there are readings beyond the limits of the sensor within the time interval being 
displayed, the statistics for the relevant interval will be displayed as "**".
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Printing the results

Printing from KeyTag Analyser is slightly different to printing from other common 
Windows software, as the printer functions in terms of range of information to print 
rather than range of pages. This technique allows you to focus on what you want 
printed rather than the pages showing the information.

You can choose to print all of the information, select a range of dates and times to 
print from or select a range of "inspection" marks. This could be a very important for 
transit monitoring since post trip and pre-event data are not significant to a discussion 
or dispute centering on a humidity and/or temperature maintenance issue.

The print window can be brought up by simply clicking once on the "Print" icon ( ) 
located on the toolbar (see "Menus and Toolbars" on page 149) or by clicking the 
"Print..." menu item from within the File menu.
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Sending a file by e-mail 
direct from Analyser

You can send files of interest to another person, by e-mail, directly from the software 
without the need to exit to your e-mail software or to deal with file attachments.

While you have the file of interest open and being displayed on the screen, just click 
once on the "Send Mail" icon ( ) located on the toolbar (see "Menus and Toolbars" 
on page 149) and your e-mail software will pop up with the file already inserted as an 
attachment. Type the desired e-mail address to send the file of interest to, add any 
message that you wish to include, and then click "Send". That is all.

Clicking the "Send..." menu item within the File menu will achieve the same results as 
clicking the "Send Mail" icon as previously described.

Note, the recipient of the file will also need to have a copy of the KeyTag Analyser 
software to open and view the file that you sent. KeyTag Analyser software is free and 
can be downloaded from the KeyLog Recorders Internet site, www.keylog.nl.

If you want to attach your data files in file formats other than the KeyTag Analyser 
format, specify the desired file formats in the Exports and Reports (on page 141) 
section in the Options (see "Customising the software" on page 115) Window. The 
data files will automatically be attached to your e-mail(s) in the desired formats.

To send a Multi Chart configuration, the configuration must first be saved to disk (see 
chapter Saving a Multi Chart configuration). The "Send Mail" command will 
automatically attach the multi chart configuration file, the annotation file (if 
annotations have been added) and the relevant individual data files to your e-mail(s).

Note: You can automatically send e-mails and upload files to ftp sites using KeyTag 
Analyser's automated SMTP and FTP functionality. Please see Automatic Uploading 
to FTP sites and automatic e-mailing on page 123 for further details.
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Calling up previous 
results

The files that have most recently opened and displayed are listed towards the bottom 
of the "File (see "File Menu" on page 150)" menu. To open other files, click the 
"Open" icon ( ) located on the toolbar (see "Menus and Toolbars" on page 149), 
which will display the "Open" file dialog similar to the following picture and allows the 
user to locate and open one or more files of interest.

You can open files from all locations accessible by the Windows™ Operating System, 
including network and ftp locations. Please refer to your operating system's help for 
more information.

Clicking the "Open..." menu item within the File menu will achieve the same results as 
clicking the "Open" icon as previously described.

After the software has been installed for the first time, there are two recently opened 
files listed in the "File" menu, even though no files have been opened yet. These are 
sample files, which were installed along with the software so that users can see an 
example of information that can be retrieved from KeyTags. These files are not 
required for the correct operation of the software and therefore may be deleted at any 
time.
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You can also open files directly from within Windows™ Explorer or from within your e-
mail software by double clicking on the file or right clicking and selecting "open" from 
the context menu. When opening files from e-mail programs that store attachments in 
temporary folders such as MS Outlook, you may be asked to store the file in a new 
location when performing further actions such as selecting multi-charts or uploading to
FTP sites.

If the software is unable to open the file, it will display an error similar to the following 
picture. Clicking on  will start the process of checking the Internet for an 
updated copy of the software.

Digital signatures

Support for digital signatures is primarily provided for compliance with the US FDA 21 
CFR Part 11 regulation - Electronic records and electronic signatures. Various industries
however, may find inclusion of digital signatures beneficial towards their quality control
and assurance systems.

Digital signatures allow users to include their digital signature within a KeyTag Analyser
file along with a meaning/reason for the inclusion of the digital signature. To add 
digital signatures to KeyTag Analyser files, the copy of the KeyTag Analyser software 
being used must be connected to the KeyTag User Server software. For more 
information about how to get the software to connect to the KeyTag User Server 
software see the "User Server (on page 146)" set of options settings and/or contact 
your local network administrator.
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While the file that the digital signature is to be added to is open and currently selected,
add a digital signature by clicking on the "Digital Signatures" icon ( ) located on the 
toolbar (see "Menus and Toolbars" on page 149), which will display the "File 
Properties" dialog with the "Digital Signatures" tab already activated, similar to the 
following picture.

Then click  to begin the process of adding a digital signature to the file. If
 is disabled, moving the mouse pointer over  and leaving it still for a 

short time will revel the reason why the button is disabled.
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Once the "Add Digital Signature" dialog is visible, enter your KeyTag Analyser user 
password and the select the meaning for the digital signature that is being added. 

Click  to permanently add the digital signature to the file or  to not add 
the digital signature. Multiple digital signatures from the same and/or different users to
KeyTag Analyser files may be added to a single file.

How secure is my data

All KeyTag files are encrypted and contain checks to detect if the file has been 
tampered with since it was originally created. If the software detects that a file has 
been tampered with, even by only one character or has become corrupted and 
therefore the data within does not represent the data originally retrieved from the 
KeyTag, the software will not open the file and display the information within.

An additional validation and security feature of the KeyTag is that it will automatically 
insert error detection codes periodically during recordings, which are used to detect 
corruption or manipulation of data. Whenever these detection codes for a block of 
recordings fails its integrity validation test, the relevant readings become marked as 
non validated readings. Non validated readings are displayed differently to validated 
readings to indicate that they have failed their integrity test. 

Non validated recordings typically occur in the scenarios following scenarios:

1 One or more readings within the non validated block of readings is not the genuine 
recorded value.

2 The KeyTag has been configured to perform continuous recordings and once the 
memory within the KeyTag has been fully used, will cause older recordings to be 
overwritten, which will thereby invalidate the error detection code and integrity 
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check for the block of readings the older recordings been overwritten exist within. 
In this scenario, it is not a problem that these recordings are non validated, rather 
it means that the particular block of recordings has only the validation and integrity
protection offered by the communications between the KeyTag and the computer 
system, which is typically the same, if not better than the level of protection offered
by every other brand of logger available in the global market, that KeyLog 
Recorders know of.

3 A communications or hardware failure has occurred during the transfer of the data 
from the KeyTag to the computer. In this scenario the problem is typically resolved 
by trying to retrieve the recordings from the KeyTag again, while ensuring the 
contacts on the back of the KeyTag are clean, that the contacts within the Interface
Cradle are clean and that the contacts within the Interface Cradle are returning 
evenly to their normal position when the KeyTag is removed. 

Since the software does not modify any of the recorded data within a KeyTag file at 
any time, if the software can open the file, regardless of how long ago it was created, 
the contents of the file will still represent the original recorded information retrieved 
from the KeyTag.

Therefore, the files created by the KeyTag Analyser software meet all criteria for data 
integrity and data security as set forth in the US FDA 21 CFR Part 11 regulations. The 
firmware code that is embedded in the processor chip of each KeyTag cannot be 
extracted or reverse-assembled. Accordingly, data sets that are recorded on the 
memory within the KeyTag cannot be downloaded or modified except by being 
transferred to a KeyTag file. There is no way to interfere with the process of the 
transfer of information between the KeyTag and the software in such a way that data 
integrity would be compromised.

Viewing file properties

The file properties window provides users with a summary of the key properties of the 
data included in the file, such as model ID and serial number, alarm bands, alert range
and range of readings, start time end time and total number of readings as well as the 
battery status. If the KeyTag has a limited number of trips left, this is also indicated 
here.

The file properties window is accessed by clicking on Properties in the File menu or 
through the toolbar command.
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Figure 33: File properties for KTL-108

114 KeyTag User Guide (2.3) 



Many of the features offered by the software can be customized to suit your specific 
requirements.

All options, excluding the User Server settings, are stored on a per user basis. 
Therefore, if more than one user operates on a single workstation the software will 
allow different customization settings for each.

In This Chapter
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The customization is performed in the Options dialogue windows, which can be opened
by clicking on the  icon in the toolbar or by selecting OPTIONS from the EDIT menu.

This will open the options window.

Figure 34: General Option Settings

To change any of the options, select the corresponding category in the left pane of the
options window. You will the see what can be changed in the right pane. Most of the 
options available will be applied as soon as you click on . For example, if the 
language selection and/or the date format are changed, all windows that are open will 
be updated without the need to restart the software. Please note, however, that these 
settings will only be permanently stored once you exit the KeyTag Analyser software.

Some of the display settings, such as decimal point and date/time formats, are not 
controlled by the KeyTag Analyser's user settings dialogues, but rather by the regional 
settings of the Windows™ Operating System. These can usually be found in the 
Control Panel under "Regional and Language Options". Please refer to your Operating 
System's documentation for further assistance. 

116 KeyTag User Guide (2.3) 



General Settings

The General Settings options allow you to change various preferences that will affect 
the overall appearance of the information shown by the software.

Figure 35: General Option Settings

Show temperatures in

This will determine what units of measurement temperatures will be displayed in. The 
options include:

 Fahrenheit (°F)

 Celsius (°C)

 Kelvin (K)

Use Font

Determines what font to use to display and print information about KeyTag recordings 
and is changed through the  button. A sample of the font selected will be shown 
to you on the screen.

Default display time interval
This drop down box allows you to set the default time zoom level. You can set this to:

 All readings

 From first reading to first inspection/download mark

 From last inspection/download mark to last reading

The setting you select here will apply to all currently open windows as well as to newly
opened windows, where a file is opened or a recorder is downloaded.

The section about Inspection and download mark zoom on page 77 explains how 
this feature works.
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Language

This instructs the software which language for the software to use for all the 
information it displays and prints.

Summary Statistics

This option allows you to specify which statistics are displayed in the Summary tab. 
The statistics can be enabled or disabled by clicking the tick box for the relevant item 
in the list.

Chart Statistics

This option allows you to specify which statistics are displayed on the charts. The 
statistics can be enabled or disabled by clicking the tick box for the relevant item in the
list.
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Charts

In the charts options dialogue various settings can be customized that influence how 
charts are being displayed in the chart tab. 

Figure 36: Chart Option Window

The Chart Options settings can be enabled or disabled by clicking the check box for the
relevant item in the list. If ticked, an item is enabled.

When you highlight an item, the color selector and other relevant controls below the 
list will become active.

Function Purpose

Heading You can combine a number of different variables and your 
own text to create a chart title. The controls work the same 
as described in the section about File Names on page 137.

Temperature 
Readings

Humidity Readings

You can select colour and style of the lines used to display 
the readings. Note you cannot disable the display of 
readings.

Temperature Markers

Humidity Markers

You can select colour and style of the marker display. You 
can also enable or disable displaying the markers.

Download Marks

Inspection Marks

You can select colour and style of the download and 
inspection marker display. You can also enable or disable 
displaying these markers.
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Above Alert Region

Within Alert Region

Below Alert Region

You can set the chart background so different background 
colours are used for the regions "at or above high alert limit",
"between high alert limit and low alert limit" and "at or below
low alert limit". This allows out-of-range and in-range data to
be spotted easily on the listed or charted data.

This can be activated independently for each region by 
enabling the corresponding check box and selecting a colour 
from the colour selection drop down box.

By default these settings are enabled, with red for "above 
alert", blue for "below alert range" and green for the non-
alert range.

By selecting a line style for the "above high alert limit" and 
"below low alert limit" regions you can improve the 
readability of the charts on black and white printouts.

The report chart does not show these shaded backgrounds.

Multi Chart Shade Enabling this check box shows the multi chart tab with the 
background selected in the colour selection drop down box. 
Disabling the check box shows the colour selected for 
"Window" in the Windows Appearance settings.

X-Axis grids

Y-Axis grids

Enabling either tick box displays vertical (x-axis) or horizontal
(y-axis) lines which help you identify readings relative to each
other. By default the y-axis grid is enabled, while the x-axis 
grid is disabled.

Non-Validated 
Readings

You can choose to include or exclude non-validated data 
from the chart display by checking or un-checking the "Non-
validated readings" check box in the list. If non-validated 
data is to be displayed, it can either appear just like validated
data, or you can define a different colour and marker style to
be used. Check the check box "Display non-validated 
readings differently:" to display non-validated data in the 
selected colour/style. 

Please refer to section How secure is my data  (on page
112) for a detailed explanation of non-validated data. 
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Show readings 
beyond specifications

Sometimes the KeyTag can record readings beyond the 
specified measurement range. In this case

 the Chart and report tabs will not show the out of range values 
and the chart curve will appear with broken lines.

 the Data tab will include "<" or ">" for each reading that is 
beyond the specification range.

 the Statistics display will include "**" for each statistic that 
includes readings that are beyond the specification range.

If the option "Show readings beyond specification" is 
enabled, all recorded reading values will be displayed, even if
they are beyond the operating range of the KeyTag.

For example, the KTL-108 has a published minimum 
temperature of -40°C. Temperatures down to -41.5°C may 
be displayed if the “Show readings beyond specification” is 
enabled, however the accuracy of recordings between -40 
and -41.5 is unknown. -41.5 will be displayed even if the 
temperature falls to a much lower actual value.

KeyLog Recorders provides no guarantee of temperature 
reading reliability or accuracy beyond the published range for
a given product and the "Show readings beyond 
specification" option is not recommended to be enabled for 
general use.

Show annotations Enable this check box to show annotations on the chart. 
Disable it to hide the annotations.

Elapsed time The "Elapsed Time" option switches the x-Axis display 
between real date&time and elapsed time since the beginning
of the display period. You can temporarily override this 
selection with the toolbar buttons (see "Toolbar 
commands" on page 158).

Y-Axis alert shade Here you can define if the the alert shading uses the 
temperature or the humidity values when displaying the chart
for KTL-508 recorders.
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Default Zoom You can define the minimum and maximum y-axis values 
initially displayed when opening the chart.

 Range of readings: this scales the chart so the maximum and 
minimum temperature displayed is just above/below the 
highest/lowest temperature reading recorded by the KeyTag. If 
you choose this option the maximum screen area is used to 
display all recorded readings.

 Range of sensor: this scales the chart to show the full 
temperature measurement range of the recorder.

 Custom range: When you select this option, an additional 
dialogue appears. Here you can enter two temperature values 
and two humidity values, which are used as maximum and 
minimum values for the chart's y-axis, regardless of the value 
of the recorded readings.

These settings are stored when the software is closed.

Regardless of these settings, you can always zoom in or out 
using the various zoom controls on page 77. When using 
the context menu in the chart tab you can also temporarily 
override the manual settings with new ones.

Automation

The Automation options determine what the software does automatically when it 
detects a KeyTag in the Interface Cradle.

Figure 37: Automatic options pane

Enable automatic download of readings from KeyTags

Instructs the software to automatically retrieve recordings from a KeyTag when it is 
placed in an Interface Cradle that is connected to the computer. While the software is 
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automatically retrieving recordings from a KeyTag an animated picture will appear on 
the screen to let the user know this action is being performed. With this function 
enabled, it is not necessary to go through the download wizard procedure. This 
function is very useful when working with multiple KeyTags.

This function can be temporarily disabled by holding down the "Ctrl" key on the 
keyboard while a KeyTag is placed in the Interface Cradle.

Reconfigure with same settings after automatic 
download

When this tick box is checked, a KeyTag will be automatically configured with the same
settings as for the previous trip, once the data have been downloaded. This option is 
greyed out if the Enable automatic download of readings from KeyTags on page
122 option is disabled.

Display readings after successful download

Instructs the software to display the recordings after downloading them from the 
KeyTag. The default display format is determined by the "Display" setting in the "File 
Settings (see "File and Folder Settings" on page 136)" option. This option will affect 
readings downloaded through the automatic download feature and when downloading 
through the Wizard approach.

Only show the latest set of readings after download

Instructs the software to only display the most recently retrieved set of readings on the
screen. If there are multiple windows of readings open and being displayed, all of 
these windows will therefore be automatically closed and only the most recently 
retrieved set of readings will be displayed.

Automatic e-mailing and uploading to FTP sites

In the same way that KeyTag Analyser files are saved to a local hard drive, they can be
automatically uploaded to an FTP site and automatically be e-mailed every time data 
from a KeyTag are downloaded.

FTP (File Transfer Protocol) is a standard which describes how files are transferred 
between different computers and networks. SMTP (Simple Mail Transfer Protocol) is 
used for e-mail and describes how electronic mail is distributed across networks. 
Detailed explanations of how both FTP and SMTP work are beyond the scope of this 
manual, however if you wish to learn more about FTP, SMTP, e-mail and networking 
please refer to one of the many good articles available on the Internet, such as the 
ones on Wikipedia or the various FTP and SMTP client providers.
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In the Automation dialogue you can select for both FTP and e-mail whether you wish 
to make the process automatic, on request, or both. If you activate manual 
uploading/e-mailing, but not automatic uploading/e-mailing, you need to press a 
button on the toolbar to upload or send the file in the currently active window. This 
button is in the form of a globe symbol, which also indicates which setting is currently 
active.

If the globe is active, and a small "F" is depicted in the lower right corner, 
automatic FTP uploading is activated.

If the globe is active, and a small "e" is depicted in the upper right corner, 
automatic e-mailing is activated.

If the globe is active, and both the "F" and the "e" are depicted, both 
automatic FTP uploading and e-mailing are activated.

If the globe is active, but no letter is displayed, neither automatic FTP 
uploading nor automatic e-mailing are activated. Manual FTP or e-mail 
functions may still both be active.

If the globe is grayed out, neither automatic nor manual FTP or e-mail 
functions are available.

When neither box for e-mailing has a tick, no e-mailing will be possible. Similarly, when
neither box for FTP upload has a tick, no uploading via FTP will be possible, however in
both cases the settings data will still remain stored.

Clicking on the FTP or E-mail settings buttons brings up the dialogue windows for the 
Basic FTP settings (on page 131) or the Basic SMTP and e-mail settings (on 
page 126). Usually this information will be provided by your network administrator. If 
your company has specific IT policies you may not be allowed to configure the settings
yourself. In this case, or if your network administrator has already created a company 
wide access for multiple users, you may be provided with a settings file called 
"UploadSettings.dat". Your network administrator will detail instructions how to import 
these settings into KeyTag Analyser.

Changing FTP or e-mail settings while files are being uploaded will display following 
dialogue box when clicking OK to close the Options window.
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Click "yes" to cancel the current upload, and "No" to continue uploading to the new 
location.

When uploading or e-mailing files a status window is displayed at the bottom of the 
KeyTag Analyser window.

 

This window shows status messages related to the FTP and e-mailing functions. The 
window can be hidden by right clicking anywhere in it and de-selecting the 
Upload/Send Status box. It can be re-displayed by right clicking anywhere on the menu
or toolbar and selecting the Upload/Send Status box.

Note: The manual e-mail function described here is different from the "send mail" 
button on the toolbar. The "send mail" button invokes your standard e-mail program, 
attaches the data file, requires you to fill in an e-mail address and press the send 
button. The manual e-mail function via SMTP does not use your standard e-mail 
program, but the configured SMTP settings and requires no further action once the 
globe button on the toolbar is pressed.

Note: Automatic upload via FTP and automatic e-mailing only work if a file is created 
by downloading data from a KeyTag in the interface. If the uniqueness settings in the 
"File and Folder Settings" are set so that certain conditions do not result in creation of 
a new file, no file is uploaded or e-mailed either.

Files with formats other than the native KeyTag Analyser format will only be e-mailed 
or uploaded automatically if specifically selected in the FTP or SMTP basic settings. 
This may be different from the settings in the Exports and Reports (on page 141) 
option dialogue.
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Note: If you upload a file via the manual or automatic FTP function, any file that 
already exists on the server with the same name will be overwritten. It is up to you to 
make sure files are created with unique file names.

Basic SMTP and e-mail settings

Disclaimer

The distribution of unsolicited e-mails provides huge inconvenience to anyone with an 
e-mail account. KeyTag Analyser's e-mail function allows the automated e-mailing of 
files to a large number of recipients simultaneously without user interaction. Some 
countries consider this as spam and will prosecute offenders.

It is therefore of the utmost importance that you as the sender obtain permission from 
the recipients to send these files. KeyLog Recorders provides this functionality as a 
feature assisting in the distribution of information between various users within an 
organization and will not assume responsibility for any misuse of its software. 

Setting up automated e-mailing requires two main pieces of information:

 The name of the SMTP server which you wish to use to send the e-mails and

 A valid user name and password for the SMTP server.

Once you click on the "SMTP Settings" button a dialogue window will appear, allowing 
you to enter the configuration data for the SMTP e-mail function. A lot of these 
settings will be familiar to you from your standard e-mail program.

Figure 38: Basic SMTP settings

If you have been supplied with access data by your network administrator we suggest 
you print the following table, enter the data into the fields provided and keep it in a 
safe place.
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Field What to enter Your details

SMTP Server Enter the name of the SMTP server 
you were given by your network 
administrator

SSL SSL stands for Secure Sockets Layer. 
You may be required to tick this box if 
your SMTP server requires a secure 
connection. Typically this setting is not 
required, and your network 
administrator will set this up if 
required.  

Use name and 
password

Some SMTP servers require an 
authentication method, especially if the
SMTP server you are using is not 
provided by your ISP, e.g. if you are 
using e-mail accounts from a hosted 
site. In this case you need to tick this 
box and provide login data for this 
SMTP server. Quite often, though, you 
will not be required to use 
Authentication. 

User Name Enter the user name you have been 
allocated by your network 
administrator required for 
Authentication. Please note that for 
authentication this often needs to 
include a full e-mail address rather 
than just the SMTP login.

Password Enter the password you have been 
given by your network administrator 
required for Authentication.

Name Enter the name as it should appear in 
the recipients e-mail program. This can
be your name ore someone else's 
name.

E-mail address Enter the e-mail address that the 
recipient can reply to by pressing the 
reply button of his e-mail program. 
This can be your e-mail address, or 
someone else's address.
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Recipients Enter the e-mail addresses of the 
intended recipients. Pressing the "add" 
button will bring up a new entry 
window where you can enter a 
recipient's name and e-mail address.

You can also highlight a recipient's 
name and edit the data or remove it 
from the list.

Subject Line Text entered in this line will be 
displayed in the subject line of the e-
mail when displayed on the recipients' 
e-mail programs. Clicking on the  
button will allow you to specify some 
file related information which will be 
entered into the subject line at the 
time of sending. You can enter your 
own text with the file related 
information.

Advanced 
settings

Press this button to display a new 
dialogue window where you can enter 
advanced SMTP settings like port 
numbers, retries and log files. Refer to 
the section about Advanced SMTP 
settings (on page 130).

Attach file in the 
following formats

Select all files that you wish to attach 
when the e-mail is sent. Each file 
ticked here will be created, regardless 
of the settings made in "EDIT - 
OPTIONS - EXPORTS AND REPORTS".

Store pending 
uploads between
sessions

This check box is ticked by default. If a
file send is interrupted due to a 
network error KeyTag Analyser will re-
attempt to send the file when it is next
started. If the feature is disabled, any 
files not sent when the software is 
closed will have to be manually re-
submitted.

As a minimum you only need to provide an SMTP server address and one recipient e-
mail address for this function to work. 
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Every time you make changes to these settings you should perform a test by pressing 
the "Send Test e-mail" button. KeyTag Analyser will

 check you have provided valid connection data,

 send a test e-mail to the e-mail addresses in the recipient list.

If any of these actions fail, KeyTag Analyser will display one of the following error 
messages:

In this case the SMTP server requires authentication, and the data provided were not 
correct. Please enter the correct authentication data.

This error message is displayed if KeyTag Analyser could not connect to the specified 
SMTP site because it could not find it. This could be due to internet connectivity issues,
due to an incorrect port name or due to a mis-spelt server name.

This error message is displayed if one or more of the addresses in the recipient list 
have an incorrect mail format (i.e. are not in the format a@b.c). KeyTag Analyser can 
only check for the correct format of the addresses, but not for correctness of the 
recipients e-mail addresses. Please note if you do not provide a correct return address,
you may not know that intended recipients are not receiving the messages.
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We recommended you add your own e-mail address to the list of recipients. This way 
you get feedback if your e-mail has been sent correctly in your e-mail program. It is 
also good practice to enter a valid and correct e-mail return address for yourself. Some
ISP's will not relay messages without a sender's address.

Advanced SMTP settings

Clicking on the "Advanced Settings" button in the SMTP settings dialogue displays 
following Window:

This will allow experienced users to change additional settings normally associated with
FTP transfers.

Field What to enter

Port Number The default port for providing SMTP connections is 25. Some 
network administrators change the port number on their 
SMTP servers to increase security and stop hacking attacks. 
If your network administrator has advised a different port for 
connection, please enter it here.

In this case you may also need to change the settings of you 
firewall.

If you wish to learn more about this topic please see any of 
the published articles on networking and TCP/IP available on 
the Internet.
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Retry If a connection cannot be established, KeyTag Analyser will 
retry to e-mail the file again after the number of minutes 
entered here. This helps eliminate e-mail errors due to 
intermittent Internet connection errors. 

Maximum Retries Enter the number of times KeyTag Analyser should try to e-
mail the file if previous attempts have not been successful.

Automatic Disconnect if 
idle

KeyTag Analyser will keep the connection to the SMTP server
active, even if currently no files are being e-mailed. This 
avoids having to exchange password and login information 
every time a file is uploaded therefore providing faster 
uploads, especially if only a slow Internet connection is 
available. After a certain amount of inactivity the connection 
is dropped to save resources. Enter the time after which you 
wish KeyTag Analyser to automatically disconnect from the 
SMTP server.

Log uploads If a tick is placed in the box next to "Log uploads" the 
message exchange between the SMTP server and KeyTag 
Analyser is recorded into a file. These files are automatically 
named "YYYY_M_D_KeyTag Analyser_SMTP.log", you can 
specify a location where the files are created, or click  to 
browse to a location of your choice.

Log Connection errors Tick this box if you wish connection errors to be logged. This 
is recommended if you frequently experience upload errors 
and you wish to discuss this issue with your network 
administrator.

Click OK to store the settings or cancel to abort.

Basic FTP settings

You will require two main pieces of information to upload data to an FTP site:
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 The name of the FTP site and a directory on the site in which the files will be stored
once uploaded and

 A valid user name and password allowing you access to this directory.

Once you have clicked the "FTP Settings" button a dialogue window will appear, 
allowing you to enter the configuration data for the FTP site access.

Figure 39: Basic FTP settings

If you have been supplied with access data by your network administrator we suggest 
you print this page, enter the data into the fields provided and keep it in a safe place.

Field What to enter Your details

FTP Server Enter the name of the FTP site you 
were given by your network 
administrator

User Name Enter the user name you have been 
allocated by your network 
administrator

Password Enter the password you have been 
given by your network administrator
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Remote folder Enter the folder in which the data files 
should be uploaded. Please note that 
not all FTP servers allow creation of 
files or folders in the root directory. 
Please discuss any of your 
requirements with your network 
administrator.

Create Folder Tick this box if the remote folder is not
yet present on the FTP site and you 
wish to create it.

Upload file in the
following formats

Select all files that you wish to have 
uploaded to the FTP site. Each file 
ticked here will be created, regardless 
of the settings made in "EDIT - 
OPTIONS - EXPORTS AND REPORTS".

Advanced 
settings

Press this button to display a new 
dialogue window where you can enter 
advanced FTP settings like port 
numbers, retries and log files. Refer to 
the section about Advanced FTP 
settings (on page 135).

Store pending 
uploads between
sessions

This check box is ticked by default. If a
file upload is interrupted due to a 
network error or because the FTP site 
is temporarily unavailable, KeyTag 
Analyser will re-attempt to upload the 
file when it is next started. If the 
feature is disabled, any files not 
uploaded when the software is closed 
will have to be manually re-submitted.

All of the above settings are required to make a successful connection to an FTP 
server.

Every time you make changes to these settings you should perform a test by pressing 
the "Test connection" button. KeyTag Analyser will
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 check you have provided valid connection data,

 if necessary create the folder you have specified and

 put a small test file in the selected location.

If any of these actions fail, KeyTag Analyser will display one of the following error 
messages:

In this case the remote folder could not be created. Please select a different folder 
name or change to a permitted location.

  

This error message is displayed if KeyTag Analyser could not connect to the specified 
FTP site because it could not find it. This could be due to internet connectivity issues, 
due to an incorrect port number or due to a mis-spelt name.

This message appears when either user name or password are incorrect.
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Advanced FTP settings

Clicking on the "Advanced Settings" button in the FTP settings dialogue displays 
following Window:

This will allow experienced users to change additional settings normally associated with
FTP transfers.

Field What to enter

Port Number The default port for providing FTP connections is 21. Some 
network administrators change the port number on their FTP 
servers to increase security and stop hacking attacks. If your 
network administrator has advised a different port for 
connection, please enter it here.

In this case you may also need to change the settings of you 
firewall.

If you wish to learn more about this topic please see any of 
the published articles on networking and TCP/IP available on 
the Internet.

Security Protocol Choose between none, SSL or TSL 1.0

Firewall/Proxy Settings Use the settings from the registry or choose your own 
settings. Please discuss these settings with your network or 
IT administrator.
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Retry If a connection cannot be established, KeyTag Analyser will 
retry the file upload after the number of minutes entered 
here. This helps eliminate upload errors due to intermittent 
Internet connection errors. 

Maximum Retries Enter the number of times KeyTag Analyser should try to 
upload the file if previous attempts have not been successful.

Automatic Disconnect if 
idle

KeyTag Analyser will keep the connection to the FTP server 
active, even if currently no files are being uploaded. This 
avoids having to exchange password and login information 
every time a file is uploaded therefore providing faster 
uploads, especially if only a slow Internet connection is 
available. After a certain amount of inactivity the connection 
is dropped to save resources. Enter the time after which you 
wish KeyTag Analyser to automatically disconnect from the 
FTP server.

Log uploads If a tick is placed in the box next to "Log uploads" the 
message exchange between the FTP server and KeyTag 
Analyser is recorded into a file. These files are automatically 
named "YYYY_M_D_KeyTag Analyser_FTP.log", you can 
specify a location where the files are created, or click  to 
browse to a location of your choice..

Log Connection errors Tick this box if you wish connection errors to be logged. This 
is recommended if you frequently experience upload errors 
and you wish to discuss this issue with your network 
administrator.

Click OK to store the settings or cancel to abort. You can restore default settings by 
clicking on "Restore defaults".

File and Folder Settings

The File and Folder Settings options help you manage the KeyTag data files. 
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Display X items in my most recently used list

This determines how many of the most recently accessed files are listed in the "File 
(see "File Menu" on page 150)" menu for quick access to be opened and viewed again.
Once this number of files has been reached, the reference to the oldest file opened will
be removed and the most recently opened file will be added to position 1. Only the file 
reference is removed from this list, the actual file is not deleted. Changing this setting 
will take effect the next time KeyTag Analyser is started.

Display

This determines how the information retrieved from a file and/or KeyTag will be first 
displayed. All other ways of displaying information will still be available regardless of 
which is selected here.

 Chart; this will display the data in a time versus humidity and/or temperature chart.

 Data; this will display a list grid (spreadsheet style) of the time versus humidity 
and/or temperature data.

 Report; this will display a condensed overview of the data including averages, 
ranges, alert results, KeyTag identification data, and a small chart.

 Summary; this will display a summary of the data, including averages, ranges, alert
results, KeyTag identification data, and other information.

File Name

Whenever information is retrieved from a KeyTag it is always automatically saved to 
disk. This entry determines the method to be used to create a meaningful name of the 
file that will contain the data downloaded from the KeyTag. 
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The button at the end of the edit control ( ) can be used to assist you with defining 
how file names are to be created by inserting the appropriate predefined element that 
matches the information you want to use. Clicking on this button will display a popup 
list, similar to the following picture to allow you select from the available elements.

To customize how the file name is created, you may use one or more of the available 
elements in any order. If you use spaces to separate the elements, these spaces will 
appear in the same location in the name of the file created. The letters must be in 
uppercase or lowercase as shown in the following table (for example, "%ID" not 
"%id") and all elements must be preceded by % if specified. Other characters that are 
included will appear in the same location and unchanged in the file name creation.

Element Meaning

%DATE The date when the KeyTag information was originally retrieved.

%DATE-TIME The date and time when the KeyTag information was originally 
retrieved.

%FINISH The date and time of the last reading recorded after being 
started. If the KeyTag was not started then this information will 
be blank.

%FINISH-DATE The date of the last reading recorded after being started. If the 
KeyTag was not started then this information will be blank.

%FINISH-TIME The time of the last reading recorded after being started. If the 
KeyTag was not started then this information will be blank.

%FIRST The date and time of when the KeyTag began recording 
information, even if it was under pre-start conditions. 

%FIRST-DATE The date of when the KeyTag began recording information, even
if it was under pre-start conditions. 

%FIRST-TIME The time of when the KeyTag began recording information, even
if it was under pre-start conditions. 
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%ID The unique KeyTag identification value.

%LAST The date and time of the last reading recorded, even if there are
only pre-start recordings.

%LAST-DATE The date of the last reading recorded, even if there are only pre-
start recordings.

%LAST-TIME The time of the last reading recorded, even if there are only pre-
start recordings.

%PRODUCTID The product identifier (part number) for the KeyTag used to 
record the data.

%SERIALNUM The unique serial number of the KeyTag.

%START The date and time the KeyTag was started to record information.
If the KeyTag was not actually started and only pre-start 
information was recorded then this information will be blank.

%START-COUNT The number of times the KeyTag has been started since 
manufacture.

%START-DATE The date the KeyTag was started to record information. If the 
KeyTag was not actually started and only pre-start information 
was recorded then this information will be blank.

 %START-TIME The time the KeyTag was started to record information. If the 
KeyTag was not actually started and only pre-start information 
was recorded then this information will be blank.

%TIME The time when the KeyTag information was originally retrieved. 

%USERID The user defined identifier for the set of information recorded by
the KeyTag.

You may use the \ character to specify that a file name definition includes a sub folder 
name as well as the actual file name, which is useful if you want to group/sort files 
automatically together, for example, by date or by User Id.

Each of the following elements within the quotes (") are not permitted, as they are not
supported the operating system ": * ? < > |". If you do include one of these elements 
in the definition of how the file names are to be created they will be replaced with the 
_ character.

If you use a date and/or a time element, the format of that element will be determined
by the settings defined in the "Date and Time (see "Dates and Times" on page 143)" 
set of options.

Folder Name

This determines the location where the files are automatically stored. The location 
defined here can specify a local drive path or a network drive path. UNC folder names 
are supported. The  button at the end of the edit control will assist you to locate the 
default store folder by browsing the folder structure available to you, if you choose to 
use it.
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Since this is the default location where files are stored, this also represents the default 
folder that will be used when searching for files to open (through the Open command 
in the File menu).

You can also use the PC's environment variables to compose a user specific pathname.
This is particularly of interest to network administrators who wish to create silent 
installations and create generic UserProfile.dat files to direct the data to a location on 
the local PC or a domain server.

You can insert these variables at any location in the path name, provided the final 
resulting name is a valid UNC folder name. Use the  button to insert following 
variables at the cursor:

Variable Meaning

%COMPUTERNAME The name of the computer as entered in the system 
description.

%USERDOMAIN The domain name of the network the user is connected to.

%HOMEDRIVE The drive letter on which the User 's documents directory is 
stored.

%HOMEPATH The path (excluding the drive letter) of the user's home 
directory.

%USERNAME The user' user name as required for logon.

A valid storage directory would be "%HOMEDRIVE%HOMEPATH\Documents\My 
KeyTag Data".

Note: Some Network Attached Storage Devices (NAS Drives) use versions of SAMBA 
(Server Message Block) file servers which do not correctly report back whether a file 
exists or not. Consequently, KeyTag Analyser will overwrite without warning an already
existing file with the same name, regardless of the settings made in the Automation
on page 122 options.

Uniqueness

This determines how the software will manage information retrieved from a KeyTag 
when a file of the same name already exists. For example, when you retrieve the 
information from the same KeyTag once every day, while the KeyTag is still recording 
and the KeyTag has not been prepared for its next use and started again. The options 
available include:

1 Always create a unique copy of files (recommended)
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If a file of the same name already exists, then the software will automatically 
append " Copy n" to the end of the file name, where "n" will be a unique number.

2 Overwrite file if the file already exists

If a file of the same name already exists, the existing file is overwritten (deleted 
and replaced) with a file that contains the information just retrieved from a KeyTag.

3 Prompt if an existing file already exists.

If a file of the same name already exists, then you will see a message appear 
asking you whether or not you want to overwrite and replace the existing file with 
the information just retrieved from the KeyTag. 

If you answer "Yes" then the action described in the option "Overwrite file if the file
already exists", previously explained, will be performed.

If you answer "No" then the action described in the option "Always create a unique 
copy of files (recommended)", previously explained, will be performed.

Exports and Reports

In addition to the native *.ktd file you can automatically create files in other formats 
every time a KeyTag is downloaded. You would use this for example if you wanted to 
perform further analysis of the downloaded data in MS Excel, or e-mail a PDF file to 
someone who does not have KeyTag Analyser installed on their computer.
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To automatically create an additional file of a different type, place a check mark in the 
tick box next to the file type in the list. You can select more than one additional file 
type.

The additional files will be automatically saved when downloading a KeyTag using the 
file name and folder location defined in the "File and folder settings (on page 136)" 
options. If during the download no new file is created (for example when downloading 
a unit that has previously been downloaded), no export data are generated either.

These file formats cannot be imported back into KeyTag Analyser. It is also not 
possible to detect any manipulation to these files since they can be edited with third 
party software.

You can select which extra information will be included in the exported data by 
highlighting the format name and clicking . In the dialogue window displayed 
adjust the options to suit and click OK to save your selection. Click cancel if you wish 
to discard any changes you have made.

For CSV files you can additionally select a custom list separator. CSV files normally use 
a comma as a separator between individual values of a row. By default, KeyTag 
Analyser uses the list separator from the "Regional and Language Options" in the 
Windows Operating System. For some regions the resulting file is strictly speaking no 
longer a CSV file, however it maintains compatibility with the import of CSV files into 
MS Excel. You can also use a self selected separator instead.

The options for the PDF files are more extensive than for other files, please see PDF 
files on page 71.

To select file formats for the e-mail attachment created through the Send Mail 
command when Sending a file by e-mail direct from Analyser on page 108, tick 
the desired file formats in the second list. The list of Send Mail file formats contains 
only file formats selected in the Export formats list, plus the KeyTag Analyser format.
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None of the formats selected here will be automatically uploaded to an FTP site, or e-
mailed through the automatic e-mailing function. Files to be automatically sent or 
uploaded are enabled in the Basic FTP settings on page 131 and the Basic SMTP 
and e-mail settings on page 126 dialogues. Customisation, however, is only 
performed in the section about Exports and Reports.

Dates and Times

The Date and Time options allow how the date and time information is displayed by 
the software to be overridden. It does not affect how the date and time information is 
stored and therefore, how the date and/or time information is shown can be changed 
at any time. At the bottom of this option window, a sample of the date and time using 
the formats selected will be displayed.

To customize how the date information is displayed, the following elements may be 
used. If spaces are used to separate the elements, these spaces will appear in the 
same location in the date displayed. The letters must be in uppercase or lowercase as 
shown in the following table (for example, "MM" not "mm"). Characters that are 
enclosed in single quotation marks will appear in the same location and unchanged in 
the date displayed. 

Element Meaning

d Day of month as digits with no leading zero for single-digit days.

dd Day of month as digits with leading zero for single-digit days.

ddd Day of week as a three-letter abbreviation.

dddd Day of week as its full name.

M Month as digits with no leading zero for single-digit months.

MM Month as digits with leading zero for single-digit months.

MMM Month as a three-letter abbreviation.

MMMM Month as its full name.
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y Year as last two digits, but with no leading zero for years less than 10.

yy Year as last two digits, but with leading zero for years less than 10.

yyyy Year represented by full four digits.

To customize how the time information is displayed, the following elements may be 
used. If spaces are used to separate the elements, these spaces will appear in the 
same location in the time displayed. The letters must be in uppercase or lowercase as 
shown in the following table (for example, "ss", not "SS"). Characters that are enclosed
in single quotation marks will appear in the same location and unchanged in the time 
displayed. 

Element Meaning

h Hours with no leading zero for single-digit hours; 12-hour clock.

hh Hours with leading zero for single-digit hours; 12-hour clock.

H Hours with no leading zero for single-digit hours; 24-hour clock.

HH Hours with leading zero for single-digit hours; 24-hour clock.

m Minutes with no leading zero for single-digit minutes.

mm Minutes with leading zero for single-digit minutes.

s Seconds with no leading zero for single-digit seconds.

ss Seconds with leading zero for single-digit seconds.

t One character time-marker string, such as A or P.

tt Multi character time-marker string, such as AM or PM.

For example, if the date was 2 January 2004 and the date format was defined as "yy-
M',' dd" (excluding the double quotes) the date would be displayed as "04-1, 02".

Time zones

The time zone of the computer used to configure a KeyTag is stored in the KeyTag's 
memory. In some cases, the configuration time zone will be different from the time 
zone at the download location. This allows you to select which time zone will be used 
to display dates and times within the chart, summary and data displays. This option 
will not have any effect on the original recorded data.
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Download Time Zone All reading times are displayed in the time zone of the computer 
used for downloading/displaying the data. This is the default 
setting.

Configuration Time 
Zone

All reading times are displayed in the time zone of the computer 
used for configuring the KeyTag.

UTC/GMT Time Zone All times are displayed in Universal Time Coordinates, or 
Greenwich Mean Time representation.

Logger Display 
Clock / Configuration 
Time Zone

All times are displayed relative to the clock that is showing on 
the display. If the unit has no display, the logger's Configuration 
time zone is used.

Logger Display clock/
Download Date

All times are displayed relative to the clock that is showing on 
the display and use the date of the download computer. This is 
the setting always applied to TRID30-7FW units.

Communication Ports

KeyTag Analyser supports communication with multiple ports simultaneously, so it is 
possible to connect and use more than one interface cradle at the same time. Each 
time you use KeyTag Analyser to configure, download or hibernate a recorder it needs 
to check each enabled port to see if an interface with a recorder is attached to that 
port. In this dialogue you can define, which communication ports should be checked 
for connected interface cradles. The more ports you leave enabled, the longer it will 
take KeyTag Analyser to establish which ports have interfaces connected, and those 
which don't.  

You should therefore only enable ports you plan on connecting an interface to. Ports 
not used for communication with KeyTag products should be excluded, which speeds 
up communication.

Figure 40: Communication Ports with COM 1 and 2 enabled
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To make the process of disabling serial interfaces easier, you can now enable the 
check box "Disable all serial ports", and only USB interfaces will be used for 
communication. This is especially useful if you have Bluetooth devices connected to 
your computer, which generate a large number of virtual COM ports. It can take 
KeyTag Analysera long time to detect if these virtual ports have an interface 
connected, so disabling the ports significantly improves communication time. Any new 
COM port established after you disable all serial ports will also be automatically 
disabled.

Figure 41: Communication Ports with all serial ports disabled

Note: USB ports cannot be disabled; if you do not wish the software to communicate 
with USB ports you must unplug any interface connected.

User Server

The User Server options define if and where the software should connect to the 
KeyTag User Server software. If you do not have KeyTag User Server software 
installed on your computer and/or available on your local area network, you will not 
need to make any changes to this set of options. Connection to the KeyTag User 
Server software is typically only used within a multiple computer user environment or if
your organization requires compliance with the US FDA 21 CFR Part 11 regulations, for 
use of digital signatures that are controlled by a central administrator.

The settings required in these fields will be provided by your network administrator. 
Once a valid connection to the KeyTag User Server software has been established, you
will be required to log on (see "How users log on" on page 165) to the software to 
continue using it.
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Note: If the KeyTag User Server software runs on a different computer you need to be 
connected to that computer via a LAN or WAN to use KeyTag Analyser software or 
make any changes to these settings.

To enter or change these settings, KeyTag Analyser must be started from a user 
account with local administrator privileges. If you normally start it from a standard user
account, please close KeyTag Analyser, right click its shortcut and click "Run as 
administrator" from the context menu. Make the changes after you have provided 
Administrator credentials, then close KeyTag Analyser and start as usual.

Figure 42: Running KeyTag software as administrator

Software Updates

The KeyTag Analyser software can periodically check if a newer version is available for 
download from the KeyLog Recorders website.

You can turn this feature On or Off by selecting the corresponding button, and set the
number of days between checks by entering a number in the "Check every XX days" 
field.

If you select On, you will be asked if you want a web browser to open a website with 
the latest download link whenever a new version is available.

If the "Automatic Update" setting is enabled, you will be taken to this site without 
further notification.
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Configuration Reports

It can sometimes be useful to keep a record of the configuration data of a KeyTag 
Recorder. KeyTag Analyser allows a number of selected configuration data to be stored
in a text file. These settings are made in the Configuration Reports window. 

When the "Log configuration data" option is ticked, the selected parameters are 
written into a text file, which is named "KeyTag Analyser_config_log_WW-YYYY", 
where WW is the current week number and YYYY is the current year. Each week a new
file will be generated.

Clicking on the  button will allow you to select a folder of your choice where the log 
files will be stored. For each logger configured a new line is started in the text file, 
individual entries in each line are separated by the character specified in the "Field 
separator" box. You can change the order of the entries in each line by selecting a 

Field and clicking on the up  or down  buttons. Clicking the tick box  
enables all parameters to be included in the log file.

Following parameters can be selected:
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At the top of the screen for the KeyTag Analyser, just below the title bar, which 
contains the name of the software, is the menu system and toolbar for the software. 
The toolbar provides quick access to some of the more commonly used functions 
within the menu system. The menu system contains lists of all the operations and 
commands that are available to you while using the software.

In This Chapter

Menu commands....................................................150
Toolbar commands.................................................158
Print preview toolbar..............................................160
Standard Window commands..................................161
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Menu commands

The menu system has been separated into groups of related commands. Each of these
menu groups is explained in more depth in the subsequent sections. The software will 
only display the menu groups and commands within each menu group that are 
appropriate depending on what you are currently doing with the software.

You may also see that some of the menu commands have a reference after the 
command name, for example F2 or Ctrl+O. These represent key strokes on the 
keyboard that instruct the software to perform the appropriate command, without out 
the need to select the menu or toolbar command. When only one key reference is 
mentioned, for example "F2", then pressing that single key on the keyboard will cause 
the appropriate command to be performed. If there is more than one key reference 
mentioned, for example Ctrl+O, then to cause the command to be performed you must
press and hold down the first key mentioned while pressing the other key once. When 
letters are used in the key reference, for example Ctrl+O, it does not matter whether 
or not the caps lock is on or off.

File Menu
The "File" menu contains commands that generally relate to a KeyTag file as a whole. 
A KeyTag file contains a variety of information that relates to a data set representing 
readings that were recorded over a discrete period of time by a single KeyTag. The File
menu will appear similar to the following picture.

The following table outlines the commands and the explanation of each command that 
may appear in the "File" menu when using the KeyTag Analyser software:
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Command Explanation

Open (see "Calling up 
previous results" on page
109)... ( )

This will display the Open file dialog, which will allow you
to open:

 KeyTag files that contain readings previously 
retrieved, or

 previously saved Multi Chart configuration files. 

It will start at the folder defined in the File and Folder 
Settings (on page 136) section in the Options (see 
"Customising the software" on page 115).

If a Multi Chart file is selected, the KeyTag Analyser 
software will automatically switch to Multi Chart mode 
and all the selected files will be added to the Multi Chart 
display.

Close This command will close all windows that are displaying 
information about the open file that is currently selected.
If no files are currently open this command will not be 
visible.

Multi Chart ( ) This will change the way recordings are displayed such 
that they are all combined on a single chart window (see 
Combining Charts into a single chart on page 92).

Single Chart ( ) This will change the way recordings are displayed such 
that each which will contain all the information retrieved 
from a single KeyTag.

Save ( ) This will save any changes you have made to the KeyTag
file (or Multi Chart configuration) to your disk drive. 

Save As... This will display the Save As file dialog, which will allow 
you to save a copy of the file currently being displayed in
the same or different folder with the same or different 
file name. 

Upload ( ) This will send an e-mail with the currently active file 
attached to a list of recipients or upload the file to a pre-
determined FTP site. See Automatic e-mailing and 
uploading to FTP sites on page 123.

Print (see "Printing the 
results" on page 107)... (

)

This will open a window allowing you to print a copy of 
the KeyTag file to an output device, which will typically 
be a printer. This command is further explained in the 
section "Printing the results (on page 107)".

Print Preview (see "Print
preview toolbar" on page
160)

This will change the display mode of the software to 
show you a copy of how a printout of the currently 
selected file and window would look like. In "Print 
Preview" mode you will not be able to zoom in or out of 
a chart. Click  to exit the "Print Preview" mode 
and return to normal display mode.
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Print Setup... This will open a window allowing you to view and/or 
adjust one or more of your printer's settings.

Page Setup... This will open a window allowing you to view and/or 
adjust one or more of your page settings, like printer 
margins and page orientation.

Send on page 108... ( ) This will help you send, by e-mail, the currently open and
selected KeyTag file to another user without the need to 
exit to your e-mail software or to deal with file 
attachments. This command is explained in further detail
in the section "Sending a file by e-mail direct from 
Analyser on page 108".

Properties (see "Viewing
file properties" on page
113)... ( )

This will open a window that will display the information 
about the file that is being displayed and currently 
selected. This same window and information will be 
displayed if you view the properties of the file from 
Microsoft Windows Explorer.

Digital Signature (see 
"Digital signatures" on 
page 110)... ( )

This will open a window to display a list of digital 
signatures that have been included with the file. It also 
allows you to add and print this list of digital signatures. 
This command is explained in further detail in the section
"Digital signatures (on page 110)".

User logon (see "How 
users log on" on page
165)... ( )

This allows a user to logon to and use the Analyser 
software. When the software is connected to the User 
Server software, users must logon to the software prior 
to being permitted to use the software. Therefore, this 
command will only be available if the Analyser software 
is connected to the User Server software. If a user is 
already logged on to the software, then this command is 
not visible. The section "User Server (on page 146)" 
explains in more detail how to get the Analyser software 
to connect to the User Server software.

Logoff user (username) 
(see "How users log on" 
on page 165) ( )

This allows the currently logged on user to logoff the 
Analyser software. The username portion of this 
command will represent the name of the user currently 
logged on. If there is no currently logged on user, this 
command is not visible.

Change Password (see 
"How users change their 
password" on page 166)...

This allows the currently logged on user to modify their 
password that they use to logon to the Analyser 
software. This command will only be available if the 
Analyser software is connected to the User Server 
software and the User Server administrator has granted 
the appropriate user permissions.
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1, 2, 3, etc This portion of the menu represents a list of the most 
recently files you have viewed. To reopen one of these 
files, simply click on the entry (name of the file) to open.
If a file that you want to view is not included in this list, 
you may use the "Open..." command included in this 
menu. The number of files included in this list can be 
adjusted through the "General Settings (on page 117)"
section of the Options (see "Customising the software" 
on page 115).

Exit This command will exit and close down the KeyTag 
Analyser software. Any files that you currently have open
will also be closed automatically for you. If a user is 
currently logged on to the Analyser software when the 
Analyser closes, the user will be automatically logged off.

 

Edit Menu
The "Edit" menu contains commands that generally relate to the contents of a KeyTag 
file and will appear similar to the following picture.

Figure 43:  KeyTag Analyzer Edit Menu

The following table outlines the commands and the explanation of each command that 
may appear in the "Edit" menu when using the KeyTag Analyser software:

Command Explanation

Copy ( ) Places a copy of the contents of the currently displayed
window onto the clipboard, which can then be pasted 
into any Windows® application. If you are copying a 
chart, the chart at its current zoom range is copied to 
the clipboard. If you are copying from one of the 
tabular style windows (Data or Summary), then the 
entire contents of the window is copied to the 
clipboard, regardless of what part of the data you have 
scrolled to view.

Zoom Out ( ) This will undo the last zoom operation performed 
allowing you to see more of the data on the chart. If 
the chart is displaying all the readings recorded by the 
KeyTag, this command will not be available. 
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Real time ( ) Clicking this menu item will make the time axis 
represent date and time the data were recorded. This is
useful when you want to inspected at what date and 
time a certain event occurred. 

Elapsed time ( ) Clicking this menu item will make the time axis 
represents the elapsed time since the recording began. 
This is useful when you want to inspected how long 
into a trip a certain event occurred.

Zoom to Marks ( ) When this command is enabled, the chart is 
automatically zoomed to show readings recorded 
between inspection marks. The section "Starting and 
using the KeyTag (on page 27)" explains in further 
detail how inspection marks are recorded.

Previous group of Marks (

)

This command will show the readings recorded 
between the first inspection mark shown and the 
previous inspection mark recorded. This command will 
only be available if the "Zoom to Marks" command is 
enabled and the first reading recorded is not currently 
visible.

Next group of Marks ( ) This command will show the readings recorded 
between the last inspection mark shown and the next 
inspection mark recorded. This command will only be 
available if the "Zoom to Marks" command is enabled 
and the last reading recorded is not currently visible.

Options (see "Customising
the software" on page
115)... ( )

This will open a window allowing you to customize the 
software. This command is further explained in the 
chapter "Customizing the software (see 
"Customising the software" on page 115)".

KeyTag Menu
The "KeyTag" menu contains commands that generally relate to the usage and 
interaction with KeyTags. 
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The following table outlines the commands and the explanation of each command that 
may appear in the "KeyTag" menu when using the KeyTag Analyser software:

Command Explanation

Configure... (see 
"Getting a KeyTag ready
for use" on page 32)

This will display a wizard to help you through the 
necessary steps to prepare KeyTags for their next use. 
This command is explained in further detail in the chapter 
"Preparing KeyTags for use on page 31".

Download... (see 
"Getting results from 
KeyTag" on page 65)

This will display a wizard to help you through the 
necessary steps to retrieve a copy of the recorded 
readings stored within the KeyTag(s). This command is 
explained in further detail in the chapter "Results from 
KeyTag (on page 64)".

Hibernate... (see 
"Hibernation - 
Prolonging battery life" 
on page 61)

This will display a wizard to help you through the 
necessary steps to set KeyTags to "Hibernation" mode. 
This command is explained further in the chapter 
"Prolonging battery life (see "Hibernation - Prolonging 
battery life" on page 61)"

Quick Re-configure... 
(see "Quickly re-
configuring KeyTags" on 
page 60)

With this command you can re-configure a logger with the
same settings as for the previous trip. This command is 
explained in further detail in the section "Quickly re-
configuring KeyTag (see "Quickly re-configuring 
KeyTags" on page 60)s"

Profiles... (see 
"Configuration Profiles" 
on page 55)

With this command you can configure a logger with a 
configuration profile previously created. This command is 
explained in further detail in the section about 
"Configuration Profiles (on page 55)"

Wizard (see "Preparing 
a KeyTag for recording" 
on page 21)... ( )

This will display a wizard to help you through the 
necessary steps to retrieve a copy of the recorded 
readings stored within the KeyTag(s) and then prepare the
KeyTags for their next use. This command is explained in 
further detail in the chapter "Quick Start Guide (on page
18)".

Menus and Toolbars 155



Window Menu
The "Window" menu contains commands that relate to the management of each 
Window open within the KeyTag Analyser software that displays the contents of a 
KeyTag file. 

The following table outlines the commands and the explanation of each command that 
may appear in the "Window" menu when using the KeyTag Analyser software:

Command Explanation

New Window Opens a new window that contains a copy of the 
information of the currently selected window. This 
command is useful when you need to closely inspect and 
analyze different sections of the same data set.

Close Closes the currently selected window within the KeyTag 
Analyser software.

Close All Closes all the windows within the KeyTag Analyser 
software.

Cascade Arrange all the windows within the KeyTag Analyser 
software in an overlapping style.

Title Horizontally Arrange all the windows within the KeyTag Analyser 
software as horizontal non-overlapping tiles.

Title Vertically Arrange all the windows within the KeyTag Analyser 
software as vertical non-overlapping tiles.

Arrange Icons Arrange all the minimized windows within the KeyTag 
Analyser software at the bottom of the main window.

1, 2, 3, etc The tick mark beside these entries indicates the window 
that is currently selected. If you want to change the 
currently selected window to one of the windows listed, 
just click/select the appropriate entry on this list.
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Help Menu
The "Help" menu contains commands that relate to providing you with help and 
assistance with using the KeyTag Analyser software. 

The following table outlines the commands and the explanation of each command that 
may appear in the "Help" menu when using the KeyTag Analyser software:

Command Explanation

Help Topics ( ) Opens a window that contains the online help.

User Guide ( ) Opens the online user guide for viewing. Requires 
Adobe Acrobat and/or Adobe Acrobat Reader 
software, version 4 or later, to be installed on the 
computer.

KeyTag Home Page... ( ) This will open your default Internet browser 
software and display the KeyLog Recorders Internet 
site, www.keylog.nl. This command requires that 
your computer be currently connected to the 
Internet to successfully display the KeyLog 
Recorders Internet site.

Request help (see "Getting 
more help" on page 164)... (

)

This will gather non personal information from your 
system to include in the e-mail to be sent to 
software support at KeyLog Recorders, so that the 
support team will be informed of the relevant 
information about your system in order to provide 
you with quality and useful assistance. This 
command is explained in further detail in the chapter
Getting more help (on page 164).

Check Internet for update... This is a simple way of checking to see if there is a 
newer version of this software available for 
download. This command is explained in further 
detail in the chapter about Upgrading Analyzer on
page 14.

About KeyTag Analyser 
(see "Finding your software 
version" on page 163)... ( )

Display the version information about the KeyTag 
Analyser software that you are using.
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Toolbar commands

Each icon on the toolbar represents a unique command. 

Access KeyTag

This will bring up the KeyTag Wizard, which will take you through the steps to 
retrieve readings from connected KeyTag(s) and prepare them for their next 
use. 

Open

This will display the file open window to allow you to locate and open KeyTag 
files that contain previously retrieved KeyTag readings.

Save

Save a copy of the KeyTag data to a file on your disk drive.

Print

Opens the window that will allow you to print a copy of the KeyTag data to a 
printer.

File properties

Displays file properties about the currently selected open file.

File digital signatures

Displays information about any digital signatures included in the currently 
selected open file, which is also allows where new digital signatures can be 
added to the file and where you can print a copy of the digital signatures.

Send mail

Creates a new blank e-mail for sending a copy of the currently selected open 
file as an attachment to a recipient of your choice. 

Upload

Uploads the file in the currently active window to an FTP server, or sends it by 
e-mail. Please see Automatic e-mailing and uploading to FTP sites on 
page 123.

Copy

Places a copy of the currently displayed information to the Windows clipboard 
so that you can paste it into another Windows software package.
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Real time

When this button is active, the time axis represents date and time the data 
were recorded. This is useful when you want to inspected at what date and 
time a certain event occurred. 

Elapsed time

When this button is active, the time axis represents the elapsed time since the 
recording began. This is useful when you want to inspected how long into a 
trip a certain event occurred.

Zoom out

Zooms out one level of the chart in the currently active window. If you are 
displaying a chart and this function is not available, then all available data are 
already being displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the oldest reading 
recorded and the first inspection mark that exists in the data. If this function is
not available then there are no inspection marks in the data currently being 
displayed.

The next two commands will not be available until this command is activated.

Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the
first inspection mark currently being displayed and the previous inspection 
mark.

This function is disabled when either the oldest reading is already being 
displayed, or the "Zoom to inspection marks" function has not been activated. 

Next inspection mark group

This zooms the chart so readings are shown which were recorded between the
last inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being 
displayed, or the "Zoom to inspection marks" function has not been activated.

Average

Combines all open file windows into a single Multi Chart window and activates 
the average tab. , or if already in multichart, activates or disables the average 
tabs. It is recommended to deactivate this feature when processing large data 
sets, as Minimum, Maximum and Average Charts (see "Special Chart 
Tabs" on page 97) can require considerable memory and processor resources 
when activated.

Multi Chart

Switches into Multi Chart mode, which displays all currently open charts 
together in one window. If additional KeyTag(s) are downloaded or more files 
opened, their data will be added to the Multi Chart window.
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Single Chart

Switches into Single Chart mode. Each chart that is currently open will be 
displayed in its own window.

Options

This will open a window allowing you to customize the software. This 
command is further explained in the chapter "Customizing the software 
(see "Customising the software" on page 115)".

Logon/Logoff user

This will log a user on to the software if no user is currently logged on or log 
off the currently logged on user. This command will only be available if the 
software is connected to the KeyTag User Server software.

Help

Click on this icon, then click on an area on the screen, and the help topic for 
this area will be displayed.

Print preview toolbar

The print preview feature, available through the File menu (on page 150), of the 
software will display copy of the data as it would be included on a print out. When the 
software is displaying a file in print preview mode, an additional toolbar will appear, 
similar to the following picture:

Command Explanation

Print (see "Printing the 
results" on page 107)...

This will open a window allowing you to print a copy of 
the KeyTag file to an output device, which will typically 
be a printer. This command is further explained in the 
section "Printing the results (on page 107)".
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Next Page This will display the next page included in the print out. 
This button will be disabled if there are no more pages 
available to be displayed.

Prev Page This will display the previous page included in the print 
out. This button will be disabled if there are no previous 
pages available to be displayed.

One Page Selecting this button will change the display so that only 
one page is displayed at a time. Once this button is 
selected it will change to "Two Page".

Two Page Selecting this button will change the display so that two 
consecutive pages are displayed side by side at the same
time. This button will be disabled if there is only one 
page in the print out, like a chart. Once this button is 
selected it will change to "One Page". 

Zoom In This will zoom in the display of the print out making it 
appear larger on the screen. It will not affect what 
information is included in the print out.

Zoom Out This will zoom out the display of the print out making it 
appear smaller on the screen. It will not affect what 
information is included in the print out.

Close This will close the print preview mode of display and 
revert the display of the data back to normal mode, 
which will allow users to switch between chart display 
and data listing display, for example.

Standard Window 
commands

In the top right corner of each window, one or all of the buttons in the following image
will be displayed and will (from left to right) minimize the window, maximize the 
window or close the window.
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The following picture illustrates an example of the menu that will appear if a user 
selects the icon in the top left corner of the KeyTag Analyser software, usually by 
clicking the left mouse button on it, or by clicking the right mouse button on the title 
bar (see "Menus and Toolbars" on page 149). The commands illustrated in the 
following picture allow you to change the location and/or size of the window containing
the KeyTag Analyser software. Users can also move the window containing the KeyTag
Analyser software by "dragging" the title bar, which is typically performed by pressing 
and holding the left mouse button down over the title bar of the software and moving 
the mouse to the new location for the window.

The following picture illustrates an example of the menu that will appear if a user 
selects the icon in the top left corner of a data file window, usually by clicking the left 
mouse button on it, or by clicking the right mouse button on the title bar (see "Menus
and Toolbars" on page 149) of the data window. These menu commands will only 
affect the window containing the data retrieved from a KeyTag rather than the Window
that contains the entire KeyTag Analyser software.
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In This Chapter

Finding your software version.................................163
Getting more help..................................................164

Finding your software 
version

Within the "Help (see "Help Menu" on page 157)" menu, is the "About KeyTag 
Analyser..." command, which will display a Window similar to the following picture.

Within this window, amongst other information, the full version number of the software
being used is displayed. This information is useful, for example, to determine if the 
same software version is installed on multiple computers and/or if the user guide being
referenced refers to the version of software being used. 

For example, if the window shows the software to be "KeyTag Analyser 2.3" and the 
version of this guide is 2.3, then the contents of this user guide refer to the version of 
software being used. If however, this window shows the software to be "KeyTag 
Analyser 1.0" and the version of this guide is 2.3, then this version of the user guide 
does not refer to the version of the software being used. The version of this guide is 
2.3, which is also shown on the cover page of the guide. 

Each time the software is updated one part of the version number of the software is 
always increased. The "Build" number portion is increased for a given version of the 
KeyTag Analyser software when the change included in the software will not affect the 
matching version of the user guide. For example, version 2.3 of the guide refers to 
both the "KeyTag Analyser, Version 2.3 Build 2" and the "KeyTag Analyser, Version 2.3
Build 5" of the software. 
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Getting more help

The time may arise when this guide is unable to provide you with the assistance you 
require. The KeyTag Analyser software includes a way to make the process of getting 
further assistance from KeyLog Recorders as simple as possible, while providing the 
support team at KeyLog Recorders with enough information about your system to be 
able to provide you with useful assistance. Within the "Help" menu of the software is a 
"Request help..." command. 

This command will gather non personal information from your system to include in the 
e-mail, which you can review if you want to, so that KeyLog Recorders will be informed
of the relevant information about your system in order to provide you with quality and 
useful assistance.

The software will also try to collect as much information as possible from any logger in 
an interface attached to the computer. It is therefore important you do not remove any
logger from attached interfaces while this process continues. You will see following 
warning message displayed on screen:

Figure 44: Diagnostic data collection

The file(s) attached will have a *.mem (for memory) file extension which can only be 
viewed with special diagnostic software by KeyLog Recorders, but not with KeyTag 
Analyser software.

Please also include in the e-mail as much and detailed information as possible about 
the problem that you are experiencing with the recorders or the software, even if you 
do not think it is relevant, as the more information is available, the more likely KeyLog 
Recorders will be able to provide you with an appropriate solution quickly.

If you have suggestions for software improvements, you may also use this method to 
send your ideas to KeyLog Recorders, as we are always in the process of improving the
software and adding additional features to it, so that the software becomes 
increasingly more efficient, effective and useful for users.
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Troubleshooting.....................................................167
Finding your computer specifications.......................168
Code Pages............................................................173

Connecting to KeyTag 
User Server

When the software has been customized (see "Customising the software" on page
115) to be connected to the KeyTag User Server (see "User Server" on page 146) 
software, all users are required to successfully logon to the software before being 
permitted to use any of the features and functionality of the software

How users log on
For a user to successfully logon to the software, the user must enter their username, 
which the administrator would have assigned, and their password. Usernames are 
typically not case sensitive, however passwords are. That is, entering the username 
"Bob Smith" is the same as entering "BOB SMITH" and "bob smith". However, entering
a password of "bob" rather than "Bob", for example, is considered to be different.

Every logon attempt, whether successful or not, may be recorded automatically in the 
audit logs by the administrator. As a security measure, the network administrator may 
configure the KeyTag User Server (see "User Server" on page 146) software so that 
a user account becomes locked and therefore temporarily inaccessible if a certain 
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number of consecutive failed logon attempts are made to the user account. Please 
contact your network administrator if you have problems logging on.

How users change their password
When the software has been customized (see "Customising the software" on page
115) to be connected to the KeyTag User Server (see "User Server" on page 146) 
software, the network administrator may require and/or permit users to change the 
password used to logon to the software. Users are only permitted to change the 
password for the user account that is currently logged on, which is typically their own, 
and as a security precaution, users will always need to supply their current logon 
password before being permitted to change it. 

The network administrator may enforce certain rules pertaining to what is a valid 
password. For example, they may require a minimum number of characters (digits, 
letters or symbols) and/or a minimum number of digits to be included in the password.
Please contact your network administrator if you have problems with the logging on 
the software.

Passwords should be chosen such that they would be difficult for some one else to 
guess. If another person was able to guess the password they would be able to logon 
and impersonate the user. Therefore, following are a few points to remember when 
changing a password:

1 Do not use something that is personal to the user. Birth dates, license plate 
numbers, names of family members, types of vehicles owned, favorite foods and 
address of residence are all examples of passwords that should NOT be used.

2 Do not write it down.

3 Change the password on a regular basis.

If a user's password is forgotten, the network administrator will be able to change it. 
However, network administrators will not be able to see and therefore inform users 
what their current password is.
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Troubleshooting

Problem Solution

My KeyTag appears to be “dead”. 
No lights are flashing.

This could represent either of two conditions:

1 The KeyTag is ready to start, but has not 
been started yet.

2 The KeyTag is simply in a state where the 
configuration has the LED flashing turned 
off. This is an option that may be selected 
when a KeyTag has been shipped to the user
for the first time (to preserve battery life) or 
it may be that the last configuration setting 
selected no LED display.

3 The KeyTag is in "Hibernation" mode. Refer 
to "Prolonging battery life (see 
"Hibernation - Prolonging battery life" on 
page 61)" for further information.

4 The battery is dead and the KeyTag is 
expired.

How to test: 

1 Try pressing the START MARK button on the 
KeyTag.

2 Start the KeyTag Analyser software and 
place the KeyTag into the Interface Cradle. 
Download the KeyTag. If the KeyTag can be 
identified by the software, then the battery 
is good, and the KeyTag is OK.

I am unable to get a serial port 
“free”. Every time I run the 
software, every port shows that is 
already in use

On rare occasions it may be difficult to configure
some computers for releasing the assignment of
a serial port from one application to another. 
Often, this will require the services of a 
computer technician or expert. One simple 
solution is to purchase a USB Interface Cradle. 
USB connections do not have a “free port” 
limitation.

What happens if there is an 
electrical current between the 
contacts…will that damage the 
KeyTag?

The contacts are isolated from the critical 
internal component such that incidental static 
discharge will not harm the KeyTag. Deliberate 
application of a full outlet voltage (100 – 240 
volts AC or 12-24 volts DC) to the KeyTag may 
cause permanent damage.

Appendix 167



I cannot view the user guide that 
came with the software.

The User Guide is in a 'PDF' file format and as 
such a special software package called "Acrobat 
Reader" is required to view it. Acrobat Reader is
available for free download from the Adobe web
site and can typically be downloaded from 
http://get.adobe.com/reader/ 
(http://get.adobe.com/reader/) 

I cannot see all the readings in the
"data" screen, some appear to be 
missing.

The range of readings shown in the data screen 
represent the range of readings shown on the 
Chart screen. Whenever the Chart is zoomed in 
to show more detail the range of readings 
shown in the data screen is updated as well. If 
the chart is zoomed out ( ) to show all 
readings that were recorded, then the data 
screen will also show all the readings that were 
recorded.

Why are some of the readings 
shown "non validated".

The KeyTag automatically inserts error detection
codes every 127 recordings which checks for the
detection of corrupted or manipulated data. If 
the KeyTag has been configured to do 
continuous recording (see "Continuous 
operation" on page 53) then as each block of 
127 logs is started to be replaced with the latest
readings the data integrity error check for the 
"oldest" block will fail, which will therefore 
technically putting the block of data into doubt. 
This is not a problem rather that the particular 
block of data now has the lost a degree of data 
integrity protection and hence is labelled 'non-
validated'.

Non-validated readings can also occur if there 
has been communications issues during data 
transfer from the KeyTag or if the memory does
actually have a fault, however these causes are 
very rare.

 

If above suggestions are insufficient, please check the website at www.keylog.nl for 
more information, specifically the FAQ section.

Finding your computer 
specifications

If you are unsure of your computer specifications you can find the relevant information
by following these steps:
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1 To determine your computer CPU, RAM and version of Windows Operating system:

a) Open the "Control Panel". This can be done by using the mouse to click on the 
Windows "Start" button, typically located in the bottom left of the screen, to 
open the Start menu.

b) Once the "Start" button has been clicked, you will see a menu appear. 

c) If your menu looks similar to the following picture, click on the visible "Control 
Panel" item.

 

d) Within the "Control Panel" window there is a "System" icon. For Windows XP 
users, you may need to "Switch to Classic View" to locate the "System" icon 
quickly. Start (open) the "System" icon once you have located it.
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e) Clicking on the "General" tab at the top of the "System Properties" window, 
which is usually the default, will display the relevant information for you about 
your system.

2 To determine your screen resolution and colors:

a) Open the "Control Panel" as explained in step 1.

b) Open the "Display" item.

c) Click on the "Settings" tab at the top of the "Display Properties" window will 
display the relevant information for you about your display.
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d) From the "Settings" portion of the "Display Properties" window you will see your
current screen settings and you may also be able to change some of your 
display settings if you want. 

3 To determine your spare hard disk drive space:

a)  Open "My Computer" which is typically located on your desktop and/or within 
the Windows "Start" menu.
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b) Using your mouse, click the button on the right over the drive that includes 
"(C:)" in its description.

c) Select "Properties" (left mouse click) from the popup menu that will appear.
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d) Clicking on the "General" tab at the top of the drive properties window will 
display the relevant information for you about your hard drive.

e) If you have multiple (hard disk) drives installed on your computer you can 
repeat steps (b) through to (d) for each drive to get the same type of 
information.

Code Pages

A computer determines which character to display based on a table of values, which is 
specific to a language. This table is often referred to as the code page.

A small number of characters are independent of a computer's input language. These 
are '1-9', 'a-z', 'A-Z' and some special characters.
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Figure 45: ASCII table of printable characters

An additional 128 characters are available, which are specific to each code page. The 
following examples show for example the differences between the available characters 
for the Latin and Thai code pages.
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Figure 46: Extended characters of code page 1252 (Latin)

Figure 47: Extended character of code page 874 (Thai)

In KeyTag Analyser password and user ID fields are text entry fields. The code page is 
used to determine which characters KeyTag Analyser displays on screen and stores 
inside a logger. Which code page is selected depends on which input language you 
have selected for your computer. When the KeyTag is downloaded in a different 
country, the user ID is displayed with the characters from the code page who's 
reference is stored in the recorder. This is possible because all Windows code pages 
get installed as part of the operating system installation since the introduction of 
Windows XP, although only one is used at a time to display characters.

Passwords are always displayed with the asterisk character, but you will need to type 
them into a confirmation dialogue (especially if the password on download feature is 
enabled). You can use the Windows character map to enter characters that are not 
available in your language. To access the Windows character map, enter 
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charmap.exe in the "Search" or "Run" box of the Start menu, depending on your 
operating system, and press Enter.

Figure 48: Accessing the Character Map in Windows XP

Figure 49: Accessing the Character Map in Windows 7

Some code pages make more than these extra 128 characters available, but this 
requires more storage in the recorder's memory, which reduces the number of 
characters available for password and user ID. These languages are Chinese 
(Traditional), Chinese (Simplified), Korean and Japanese. For every character not in 
the ASCII character table above the number of characters that can be stored is 
reduced by one. This means a password can be as short as 3 characters, and a 
description as short as 19 characters (or 18 characters for a KT-108-D or KTL-208-D). 
The sample below shows the extended character overview and a character subset.
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Figure 50: Extended character of code page 932 (Japanese)

Figure 51: Character sub set of code page 932 for leading 91

You can find more information about the history and technical background of code 
pages via a number of online references.
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Note: Although you can use the Windows character map to confirm a password on 
download, you cannot enter characters as a new password or description that are not 
available in your chosen input language with this method. If you want to use different 
characters you must switch the input language of your computer. Please refer to the 
instructions relating to your specific operating system how to do this.

 

178 KeyTag User Guide (2.3) 



A

Advanced Alert Settings • 41, 44
Advanced FTP settings • 123, 125
Advanced SMTP settings • 119, 121
Alert Processing • 27, 38, 42
Aligning Charts • 87, 90
Analysing the results • 65
Appendix • 154
Automatic e-mailing and uploading to FTP 

sites • 99, 114, 141, 147
Automatic Re-Configuration after 

Download • 54, 58
Automatically calculated statistics • 91
Automation • 54, 59, 113, 130
Average Reading • 91

B

Basic FTP settings • 115, 122, 132
Basic SMTP and e-mail settings • 115, 

117, 132

C

Calling up previous results • 100, 141
Changing Chart Colours • 85
Chart annotations • 69, 70, 72, 76
Chart Display • 67
Chart Statistics • 85, 97, 109
Chart subtitle • 69, 74
Charts • 38, 42, 69, 70, 84, 85, 87, 89, 

110
Code Pages • 32, 34, 162
Combining charts onto a single chart • 59,

60, 66, 84, 141
Communication Ports • 23, 135
Configuration Profiles • 21, 49, 144
Configuration Reports • 138
Configure KeyTag(s) for next use • 24
Connecting the Interface • 18
Connecting to KeyTag User Server • 154
Continuous operation • 35, 47, 157
Customising the software • 84, 85, 89, 99,

106, 141, 142, 144, 148, 154, 155

D

Data Display • 79
Dates and Times • 129, 133

Day Summary Display • 81
Default display time interval • 108
Degree Minutes • 96
Digital signatures • 101, 142
Display • 127
Display Logger Alarms • 44
Display readings after successful download

• 114
Display X items in my most recently used 

list • 126
Displaying statistics • 97

E

Edit Menu • 70, 143
Enable automatic download of readings 

from KeyTags • 113, 114
Exports and Reports • 59, 64, 99, 116, 

131

F

File and Folder Settings • 114, 126, 131, 
141

File Menu • 59, 60, 61, 64, 73, 75, 100, 
126, 140, 149

File Name • 59, 110, 127
Finding your computer specifications • 11, 

157
Finding your software version • 9, 14, 146,

152
Folder Name • 129
FTP • 114, 125

G

General Settings • 71, 108, 142
Getting a copy of the software • 11, 14
Getting a KeyTag ready for use • 30, 144
Getting more help • 146, 153
Getting more information • 152
Getting results from KeyTag • 58, 144
Getting the best from your KeyTag • 48

H

Help Menu • 146, 152
Hibernation - Prolonging battery life • 27, 

35, 55, 144, 156
How secure is my data • 103, 111

Index

179



How users change their password • 142, 
155

How users log on • 136, 142, 154

I

Inspection and download mark zoom • 70,
108

Installing the software • 10
Introduction • 9

K

KeyTag light patterns • 26, 27
KeyTag Menu • 144

L

Language • 109
Locate KeyTag(s) download and save 

relevant data • 23

M

Manual Scaling • 70
Mean Kinetic Temperature • 94
Menu commands • 140
Menus and Toolbars • 98, 99, 100, 102, 

139, 150
Minimum, Maximum and Average Charts • 

88

O

Only show the latest set of readings after 
download • 114

P

Page Setup • 140
Password Rules • 32
PDF files • 59, 64, 132
Prepare KeyTag(s) for next use • 24
Preparing a KeyTag for recording • 20, 

145
Preparing KeyTag for next use • 33
Preparing KeyTag(s) for use • 24, 26, 29, 

46, 55, 144
Pre-start data collection • 35, 46, 66
Print preview toolbar • 141, 149
Printing the results • 98, 141, 149
Profile Control Buttons • 50
Profile File Controls • 51
Profile Storage File Name and Path • 51
Profile Window Controls • 52
Profiles Grid • 50
Protecting Recorded Data • 31

Q

Quick Start Guide • 17, 145
Quickly re-configuring KeyTags • 21, 53, 

144

R

Reconfigure with same settings after 
automatic download • 114

Report Display • 76
Restricting Access • 31, 36
Results from KeyTag • 28, 57, 144
Retrieve information from KeyTag • 28

S

Saving a file for use in spreadsheets • 63
Saving a Multi Chart file • 59
Saving KeyTag Data • 59
Saving KeyTag Data files • 59
Selected KeyTag Data files (*.sktd) • 59, 

61
Sending a file by e-mail direct from 

Analyser • 99, 132, 142
Shifting chart start times • 85
Show temperatures in • 108
SMTP • 121
Software Updates • 14, 137
Special Chart Tabs • 85, 88, 148
Standard Deviation • 92
Standard Window commands • 150
Starting and using the KeyTag • 25, 143
Starting the software • 15
Summary Display • 80
Summary Statistics • 80, 97, 109
System requirements • 11

T

The installation process • 13, 14
Toolbar commands • 70, 112, 147
Troubleshooting • 156

U

Uniqueness • 59, 130
Upgrading KeyTag Analyser • 13, 146
Use Font • 108
User Server • 101, 136, 142, 154, 155
Using the KeyTag with the Interface • 19

V

Verify Access Password • 36, 46
Viewing file properties • 104, 142

180



W

Welcome • 22
Window Menu • 145
Working with batches of KeyTags • 47

Z

Zoom Control • 70, 76, 113

Index 181


	Copyright
	Introduction
	Installing the software
	Quick Start Guide
	Preparing KeyTag(s) for use
	Results from KeyTag
	Customising the software
	Menus and Toolbars
	Getting more information
	Appendix
	Index
	In This Chapter
	System requirements
	Getting a copy of the software
	The installation process
	Upgrading KeyTag Analyser
	Starting the software
	In This Chapter

	Connecting the Interface
	Using the KeyTag with the Interface
	Preparing a KeyTag for recording
	Using the KeyTag Wizard
	Without using the KeyTag Wizard
	Welcome
	Locate KeyTag(s) download and save relevant data
	Configure KeyTag(s) for next use
	Prepare KeyTag(s) for next use

	Starting and using the KeyTag
	KeyTag light patterns
	Retrieve information from KeyTag
	In This Chapter

	Getting a KeyTag ready for use
	Restricting Access
	Protecting Recorded Data
	Password Rules

	Preparing KeyTag for next use
	Alert Processing
	Advanced Alert Settings
	Display Logger Alarms
	Verify Access Password
	Pre-start data collection
	Continuous operation
	Working with batches of KeyTags
	Getting the best from your KeyTag
	Configuration Profiles
	Profiles Grid
	Profile Control Buttons
	Profile Storage File Name and Path
	Profile File Controls
	Profile Window Controls

	Quickly re-configuring KeyTags
	Automatic Re-Configuration after Download
	Hibernation - Prolonging battery life
	In This Chapter

	Getting results from KeyTag
	Saving KeyTag Data
	Saving KeyTag Data files
	Saving a Multi Chart file
	Selected KeyTag Data files (*.sktd)
	Saving a file for use in spreadsheets
	PDF files

	Analysing the results
	Chart Display
	Zoom Control
	Manual Scaling
	Inspection and download mark zoom

	Chart annotations
	Chart subtitle

	Report Display
	Data Display
	Summary Display
	Day Summary Display
	KeyTag recorder products with display
	KeyTag Indicator products with display


	Combining charts onto a single chart
	Changing Chart Colours
	Shifting chart start times
	Aligning Charts
	Special Chart Tabs
	Behind The Scenes


	Automatically calculated statistics
	Average Reading
	Standard Deviation
	Mean Kinetic Temperature
	Degree Minutes

	Displaying statistics
	Printing the results
	Sending a file by e-mail direct from Analyser
	Calling up previous results
	Digital signatures
	How secure is my data
	Viewing file properties
	In This Chapter

	General Settings
	Show temperatures in
	Use Font
	Default display time interval
	Language


	Summary Statistics
	Chart Statistics
	Charts
	Automation
	Enable automatic download of readings from KeyTags
	Reconfigure with same settings after automatic download
	Display readings after successful download
	Only show the latest set of readings after download
	Automatic e-mailing and uploading to FTP sites
	Basic SMTP and e-mail settings
	Advanced SMTP settings
	Basic FTP settings
	Advanced FTP settings


	File and Folder Settings
	Display X items in my most recently used list
	Display
	File Name
	Folder Name
	Uniqueness

	Exports and Reports
	Dates and Times
	Time zones
	Communication Ports
	User Server
	Software Updates
	Configuration Reports
	In This Chapter

	Menu commands
	File Menu
	Edit Menu
	KeyTag Menu
	Window Menu
	Help Menu

	Toolbar commands
	Print preview toolbar
	Standard Window commands
	In This Chapter

	Finding your software version
	Getting more help
	In This Chapter

	Connecting to KeyTag User Server
	How users log on
	How users change their password

	Troubleshooting
	Finding your computer specifications
	Code Pages


